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1.はじめに 

 

1-1. Scaffoldとは  

 

Scaffold は、DDAプロテオミクスのデータをまとめ、サンプル間での比較を主な目的としたソフトウェア

です。 

複数の検索エンジンの結果ファイルを取り込むことが可能なほか、いくつかのフリーな検索を使って raw

データ（またはピークリストファイル）から検索を行い、結果を表示させることも可能です。 

取り込んだ同定ペプチドについて、Percolatorを中心としたValidation用のプログラムを適用する事が

できます。 

取り込んだ結果について、EXCEL などでまとめた状態とは異なりスペクトルとアサインされたペプチド

の理論フラグメントピークとのマッチング状況を確認する事もできます。また Gene Ontology 情報の表示

やPathwayデータベースへのリンク、サンプル間の同定タンパク質比較といった、タンパク質の解析を補助

する機能もついています。 

検索結果については Excel スプレッドシート、mzIdentML, などに出力できるほか、Scaffold 関連製品

で取り扱う事ができる SFDBファイル、BLIBファイルを出力する事ができます。 

結果についてはファイルに保存し、Scaffold ライセンスを所有していない共同研究先でもフリーの

Viewerを使って結果を閲覧する事が可能です。 

 

1-2. Scaffoldでのデータ読み込み  

 

Scaffold のデータ取り込みには大きく分けて以下の 2種類があります。 

 

■検索エンジンの結果ファイルを読み込む 

■検索前の rawファイルまたはピークリストファイルを読み込む 

 

また、検索エンジンの結果を取り込む場合でも、改めてX!TandemやMSFraggerでの検索も実行して、

両者の結果を組み合わせてペプチドを評価する事も可能です。 

データ取り込みについての詳細な説明は 2章で行っています。 
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1-3. Scaffoldで採用されているアルゴリズム  

 

 Scaffold では、ペプチド並びにタンパク質同定の信頼性を上げるため、以下のアルゴリズムを適用する

事ができます。 

 

■ Percolator 

■ LFDR-based scoring system 

■ Peptide Prophet 

■ Protein Prophet 

 

各アルゴリズムについて、少し詳しく説明します。 

 

■ Percolator 

取り込んだデータのペプチド-スペクトルの再評価を行うと同時に、Validation も行います。スコア  

だけでなく質量精度や各種情報をもとに判断します。同定スペクトルを増やす目的で、現在 幅開く利用

されています。 

 

  論文： 

Lukas Käll, Jesse Canterbury, Jason Weston, William Stafford Noble and Michael J. MacCoss. 

Semi-supervised learning for peptide identification from shotgun proteomics datasets 

Nature Methods 4:923 – 925, November 2007 

 

■ LFDR-based scoring system 

ベイズ統計の考えに基づいており、ナイーブベイズ分類器を使った判別スコアリングを使ってペプチド

同定の検証が行われています。トレーニングデータセットの選別を繰り返し変更しながら判別スコアリン

グの最適化を実施しています。計算により local FDR(LFDR)を算出しその数値がそのままスコア化    

されています。トレーニングデータの選別は繰り返し複数回行われ、10ある分類器のうち3つずつを対象

として鍛えていきます。この繰り返し操作により誤って同定されているデータの影響が薄まり判別の正確

性が増します。 

他の（Percolator など）スコアリング手法同様、LFDR も他の検索エンジンが提供するスコアを取り  

込みます。Peptide Prophet でいう LDA や Percolator でいう SVM(Support Vector Machine)の 

分類器にあたるものとして、LFDR ではナイーブベイズ分類器から算出した対数尤度比を使って True 

Positive と False Positive ヒットの区別を判定しています。識別子の最適化にあたっては過剰適合

(overfitting)による汎化不足とならないよう工夫しています。前駆体イオン（親イオン）の誤差は判別   

スコア計算に考慮される要素の１つというだけでなく、別の観点からもスコアに影響を与えています。

Scaffold ではこのスコアについて離散型の（数え上げ方の）スコア分布でなく、より連続的なスコア分布

の関数に置き換えて計算し、確率の積算を行う際にも積分計算を行っています。 
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 論文： 

https://dx.doi.org/10.1021%2Facs.jproteome.5b00536 

 

■ Peptide Prophet 

Peptide Prophet は検索エンジンによって算出された各ペプチドのスコアの分布を連続的な曲線の 

分布に変換し、同定確率を算出するために利用します。分布の変換の際には検索に利用したデータベー

スのサイズや検索データの特徴を利用します。この曲線化されたスコア分布を使って各スコアでの同定

確率を再計算します。同定確率はそのままペプチド同定の基準にも適用されます。 

 

 論文： 

Keller, A., Nesvizhskii, A. I., Kolker, E., and Aebersold R., Empirical statistical model to estimate the accuracy 

of peptide identifications made by MS/MS and database search. 

Anal. Chem., 2002, 74 (20), pp 5383–5392 DOI: 10.1021/ac025747h 

 

 

■ Protein Prophet 

Protein ProphetはPeptide Prophet で算出された各ペプチドの同定確率をもとに、アサインされて

いるタンパク質の同定確率を算出するアルゴリズムです。Scaffold 5 ではそのアルゴリズムをさらに 

調整し、シェアペプチドかオリジナルペプチドかによって計算における貢献度を変更しています。 

 

論文 

Nesvizhskii, A. I., Keller, A., Kolker, E., Aebersold, R., A statistical model for identifying proteins by tandem 

mass spectrometry. 

Anal. Chem., 2003, 75 (17), pp 4646–4658 DOI: 10.1021/ac0341261 

 

Scaffold では取り込んだデータに対して、上記の各手法のうちいずれかの方法が適用され評価され 

ます。一方 Scaffold で準備されているアルゴリズムを使わず、各検索エンジンで検証の上出力された 

結果をそのまま取り込む方法があります。Scaffold ではこれを「Prefiltered Mode」での取り込みと    

呼んでいます。データの取り込み方に関する詳細は、「2-2-2. Prefiltered Mode で検証済みの

mzIdentMLファイルを Scaffold上の検証なしに読みこむ」をご覧ください。 

 

 

https://dx.doi.org/10.1021%2Facs.jproteome.5b00536


4 
 

2. データの読み込み 

 

2-1. 概要、データの階層構造  

  

 Scaffold でデータを読み込むには大きく分けて以下の 3つの方法があります。 

 

結果取り込みの方法 項目 お勧めのケース 

MASCOTの検索結果ファイル（datファイ

ル 、 又 は mzIdentML フ ァ イ ル ) を

Scaffold PC にコピーしてから Scaffold 

上でファイルを取り込む 

2-2 

・Scaffold と MASCOTがネットワークで 

つながってない場合 

・Scaffold の validation 手法を適用しない、

「Prefiltered Mode」を適用したい場合 

Mascot Server の ロ グ フ ァ イ ル を

Scaffold 内で開き、該当結果を選択して

ネットワーク経由で取り込む 

2-3 

・ネットワークがつながっていて Scaffold の

validation手法を利用する場合 

raw またはピークリストファイルを直接読

み込み、X! Tandem または MSFragger

で検索してその結果を取り込む 

2-4 

・X!Tandem または MSFragger での検索から 

実行したい時 

  

加えて、各結果ファイルにはタンパク質の ID (Accession) 情報のみ含まれ、アミノ酸配列情報が含まれ

ていません。Scaffold で各タンパク質のアミノ酸配列情報を見るためには、検索に使用したデータベース 

ファイルを Scaffold 上にも取り込む必要があります。MASCOT の検索結果を取り込む際、該当データ 

ベースファイルからアミノ酸配列を取得し直し、Scaffold 内の表示に反映させています。2-5 ではデータベ

ースファイルの登録方法についてご案内します。 
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[データの階層構造について] 

 

データ取り込みの際に重要な概念として、「Category」「Sample」「dat (その他取り込み可能なテキスト

/XML ファイル)」の階層構造について説明いたします。 

 

複数の dat をまとめたものが Sample、さらに複数の Sampleをまとめたものが Category です。階

層構造はデータ取り込み時に定義します。 

 

 

 

 

 

dat をまとめて表示するかどうかについては、結果表示画面「Samples」の上部にある、 

「BIO」ボタン/「MS」ボタンで切り替えることができます。datをすべて表示させる形式が「MS」です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

一方「BIO」ボタンを押すと sample以下にある datがすべてまとめられた表示がされます。 

 

 

 

 

 

 

 

 

 

 

 

 

dat Sample Category 
上層 上層 

sample 

Category 

sample 

Category 
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Scaffold でデータを取り込む際、途中でどのように取り込むのか選択する画面が現れます。以下図では 

画面内の選択肢と、この章で説明する内容の対応付けをしています。 

 

 

 

 

 

 

 

2-2. MASCOT 結果ファイルを直接指定し読み込む方法  

 

 MASCOT の結果を Scaffold に取り込む 2 つの方法のうちの１つ、MASCOT の検索結果ファイルを

Scaffold で直接指定して読み込む方法についてご案内します。2-2-1では、MASCOTの結果ファイル dat

の取り込みを紹介しています。取り込みたい MASCOT の結果が、どういう名称でどこにあるファイル   

なのか事前に確認をした上で、該当する dat ファイルを Scaffold がインストールされている PC にコピー 

する必要があります。また 2-2-2 では、mzIdentML ファイルの取り込みについてご案内します。例えば

MASCOT において、FDR が 1%など特定の数値となるよう定めたペプチド同定基準を Scaffold 上に  

おいても適用したい場合、結果画面から mzIdentML ファイルにて出力し、Scaffold で prefiltered mode 

で出力時の状態から Validationをすることなく結果として取り込む事が可能です。 

 

 

 

 

2-2. MASCOT結果

ファイルの取り込み 

2-3MASCOT Server  

から logを介して datを 

取得する 

2-4 rawファイル/ピークリスト

から検索を実施 
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2-2-1. datファイルの読み込み: validationは Scaffold上で行う方法 

 

[ MASCOT Server 上の dat ファイルの場所を確認する方法 ] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. 結果ファイルを開いた際の URLをご覧ください。例ではアドレスの最後が 

.. %2Fdata%2F20211015%2FF001332.dat  

とあり、これが dat ファイルの存在場所を示しています。この例の場合、MASCOT

フォルダ（通常 C:¥inetpub¥mascot）以下の、 

C:¥inetpub¥mascot¥data¥20211015 というフォルダの中にある、 

F001332.dat  が目的の結果ファイルです。 

URL確認 

WEBブラウザ-結果画面の場合 

2. エクスプローラーなどで該当フォルダを開き、datファイルを Scaffold 

がインストールされている PC にコピーします。ファイルコピーはネット  

ワーク経由でも、フラッシュメモリなどの外部記憶装置経由でもどちら 

でも結構です。 
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URL確認 

WEBブラウザ-Search logの場合 

1の別例 A. Search log 結果一覧から datファイルの場所を確認する方法

もあります。表示項目の中で「In」と書かれている項目のチェックボック

スにチェックを入れ、左側の「Sort / Filter」 ボタンを押すと・・・ 

1 の別例 A. 右のように、dat ファイルが

置かれているパスが表示されます。 

URL確認 

Daemonの場合 

1 の別例 B. Daemon でもパスの一覧を 

表示させることができます。 

「Result URL」の項目を御覧ください。 

ファイルが置かれている相対 path とファイル

名が表示されます 
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[ dat ファイルを指定して読み込む方法 ] 

 

以下操作方法についてご案内します。定義するデータですが、Categoryとして Controlと Treatment,

それぞれに Sampleを２種類属した計４つのデータの取り込みを想定しています。 

 

Category Sample dat 

Control Sample1 F001234.dat 

Sample2 F001235.dat 

Treatment Sample3 F001236.dat 

Sample4 F001237.dat 

 

[Control, Sample1の指定] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. New ボタンを押し (または

Ctrl+N) 取り込みを開始します 

2. 定量データを含んでいない場合、”Spectral 

Conting(Standard)” を 選 択 し ま す 。     

続いて”Next”ボタンを押します。 
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3. Sample Name、Category の欄を記入 

します。複数ファイルを取り込みかつ結果を最初

から結合し１つのファイルのように扱いたい場合

は、「MuDPIT Experiment」にチェックを入れ

ます。続いて「Next」ボタンを押します。 

4. 「Queue Search Engine Results For 

Loading」 をクリックします。 

5. 読み込む dat ファイルを選択します。

複数のファイルを選ぶことも可能です。 
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6. 同サンプルとして読み込む結果ファイルが更

にないか問われます。ない場合は画面下の

「Next」ボタンを押します。 

7. 先程の指定とは別の sample として読み込

む結果ファイルがないか問われます。ある場合は

「Add Another BioSample」ボタンをクリック

します。 
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[Control, Sample2の指定] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8. 2～6 の操作を繰り返します。今度は Sample 

名指定の際名称を変える事と、先ほどと異なる dat

ファイルを選択する事に注意してください。 
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[Treatmnt, Sample3の指定] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. 7 同様、先程の指定とは別のサンプルとして

読み込む結果ファイルがないか問われます。ある

場合は「Add Another BioSample」ボタンを

クリックします。 

10.これまで同様、取り込み操作を繰り返します。今度は

Category 名と Sample 名を変える事と、先ほどと  

異なる datファイルを選択する事に注意してください。 
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[Treatment, Sample4の指定] 

これまで同様取り込み操作を繰り返します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

以上で datのデータ取り込みは終了です。 

12. 検索で利用したデータベース

を指定します。 
13. X!Tandem （または

MSFragger ） で 検 索 を  

追加で行うか、指定します。 

（これらの検索エンジンを 

実行可能な場合のみ） 

14. Scoring （ Validation  

含む）方法を指定します。 
15. タ ン パ ク 質 の   

グループ化表示の  

有無を指定します。 

18. すべてのパラメータを選択後、”Load 

Data”ボタンを押すと取り込みが開始します。 

11.すべてのdat,sample,Categoryの取り込みが終了

したら、「Add Another BioSample」ボタンをクリック

せず「Next」ボタンを押します。 

17. Gene Ontology や

Pathway アノテーション

の有無を指定します。 

16. 結果画面表示前に

FDRの計算を実施するか

指定します。 
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2-2-2. mzIdentML読み込み: validationは取り込み前に行う方法 

 

[mzIdentML並びにMGFファイルの準備] 

 

Scaffold で取り込みたい結果について、MASCOT の結果画面にて、「Export」の As 右側の選択肢

を「mzIdentML」に変更し、「Export」ボタンを押します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ファイル出力時の条件設定を行う画面に移行します。「Target FDR」などの数値を 1%など適切な 

値に変更し、画面下部の「Export search results」ボタンを押します。 

 

 

 

 

 

 

 

1. 「 Export 」 の As 右 側 を

「 mzIdentML 」 に 変 更 し 、

「Export」 

2. FDRの数値を適切な値に変更し、

「Export Search results」 
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遷移した画面で「Download」ボタンを押します。出力されるファイルは、「F(search 番号).mzid 」という

名称のファイルとなり、ブラウザの既定のダウンロードフォルダなどに保存されます。 

このmzIdentMLファイルの作成を、Scaffold にて取り込みたい結果で繰り返し行います*1。 

*1 Mascot Daemonにて、検索実行と連動して自動的にmzIdentML ファイルを作成するオプションが準備さ

れています。 

 

 

 

 

 

 

 

 

 

 

 

 

このmzidファイルには各 queryのピーク情報が含まれていません。mzidと同じフォルダ上にピークリスト

ファイルであるMGFファイルを出力しておいておく必要があります。MGFの出力も結果画面のExportか

ら可能です。 

結果画面の Export formatで「MGF Peak List」を選択すると、画面が遷移します。 

 

 

 

 

 

 

 

 

画面下の「Export search results」ボタンを押すとMGFファイルがダウンロードされます。 

 

 

 

 

 

 

 

 

 

 

3. ダウンロードして F<search 番号>.mzid

というファイルを入手します。 
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すべての mzid ファイルを準備したら、Scaffold を起動しデータの取り込みを開始します。手順は以下の

通りです。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. New ボタンを押し (または

Ctrl+N) 取り込みを開始します 

2. 定 量 デ ー タ を 含 ん で い な い 場

合 、  ”Spectral Conting(Standard)” を  

選択します。続いて”Next”ボタンを押します。 

3. Sample Name、Category の欄を記入 

します。複数ファイルを取り込みかつ結果を最初

から結合し１つのファイルのように扱いたい   

場合、「MuDPIT Experiment」にチェックを入

れます。 

続いて「Next」ボタンを押します。 
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4. Queue Search Engine Results For 

Loading をクリックします。 

5. 読み込むmzIdentMLファイルを選択します。 

6. 同サンプルとして読み込む結果ファイルが更

にないか問われます。ない場合は画面下の

「Next」ボタンを押します。 
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7. 先程の指定とは別の Sample として読み込

む結果ファイルがないか問われます。ある場合は

「Add Another BioSample」ボタンをクリック

します。 

8. 2～7 の操作を繰り返します。Sample 名指定の際  

名称を変える事と、先ほどと異なるｍｚIdentML ファイル

を選択する事に注意してください。 
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以上でmzIdentMLの取り込みは終了です。 

９.すべての dat,sample,Category の取り込みが終了

したら、「Add Another BioSample」ボタンをクリック

せず「Next」ボタンを押します。 

10. 検索で利用したデータベース

を指定します。 

11. X! Tandem（または

MSFragger ） で 検 索 を  

追加で行うか、指定します。

（これらの検索エンジンを実

行可能な場合のみ） 

12. Scoring（Validation  含む）方法

を指定します。検索エンジン側で調整した

結果をそのまま取り込む場合、「Use 

prefiltered mode」を選択します。 

13. タンパク質のグルー

プ化表示の有無を指定し

ます。 

14. Gene Ontology や

Pathway アノテーション

の有無を指定します。 

15. すべてのパラメータを選択

後、”Load Data”ボタンを押

すと取り込みが開始します。 
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2-3. MASCOT Serverからネットワークを介して datを取得する方法  

 

 MASCOT の結果を Scaffold に取り込む 2 つの方法のうちの１つ、MASCOT のログファイルを開き、

Mascot Server からネットワークを通じて直接 dat ファイルを取り込む方法です。 

 

[ Sample を Search logから指定しネットワーク経由でファイルを取得する方法 ]  

Categoryとして Controlと Treatment,それぞれに Sampleを２種類属したデータを想定しています。 

 

Category Sample dat 

Control Sample1 F001244.dat 

Sample2 F001245.dat 

Treatment Sample3 F001246.dat 

Sample4 F001247.dat 

 

[Control, Sample1の指定] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. New ボタンを押し (または

Ctrl+N) 取り込みを開始します 

2. 定 量 デ ー タ を 含 ん で い な い           

場合、 ”Spectral Conting(Standard)”を  

選択します。続いて”Next”ボタンを押します。 
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3. Sample Name、Category の欄を記入します。

複数ファイルを取り込みかつ結果を最初から結合し  

１つのファイルのように扱いたい場合、「MuDPIT 

Experiment」にチェックを入れます。 

続いて「Next」ボタンを押します。 

4. Queue Search Engine Results For 

Loading をクリックします。 
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5. 取り込む結果をログからクリックで 

選びます（同時に複数選択をすること

も可能です）。 

「Add」ボタンを押すと下の欄に取り 

込まれた結果が表示されます。選択を

終えたら「OK」ボタンを押します。 

6. 同サンプルとして読み込む結果ファイルが 

更にないか問われます。ない場合は画面下の

「Next」ボタンを押します。 
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[Control, Sample2の指定] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. 先程の指定とは別のサンプルとして読み込む

結果ファイルがないか問われます。ある場合は

「Add Another BioSample」ボタンをクリック

します。 
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8. 2～6 の操作を繰り返します。今度は Sample 名

指定の際名称を変える事と、先ほどと異なる dat   

ファイル(Job番号)を選択する事に注意してください。 
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[Treatmnt, Sample3の指定] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. 7 同様、先程の指定とは別のサンプルとして

読み込む結果ファイルがないか問われます。ある

場合は「Add Another BioSample」ボタンを

クリックします。 

10.これまで同様、取り込み操作を繰り返します。今度は

Category 名と Sample 名を変える事と、先ほどと  

異なる dat ファイル（Job 番号）を選択する事に注意して

ください。 
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[Treatment, Sample4の指定] 

これまで同様取り込み操作を繰り返します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

以上で search logからデータ取り込む操作は終了です。 

12. 検索で利用したデータベース

を指定します 
13. X!Tandem（または

MSFragger）で検索を追

加で行うか、指定します 

14. Scoring （ Validation  

含む）方法を指定します 
15. タンパク質のグルー

プ化表示の有無を指定し

ます 

18. すべてのパラメータを選択後、”Load 

Data”ボタンを押すと取り込みが開始します。 

11.すべてのdat,sample,Categoryの取り込みが終了

したら、「Add Another BioSample」ボタンをクリック

せず「Next」ボタンを押します。 

17. Gene Ontology や

Pathway アノテーション

の有無を指定します 
16. 結果画面表示前に

FDRの計算を実施するか

指定します。 
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2-4. rawまたはピークリストを直接読み込むところから始める方法  

 

Scaffold 5 からは、raw データを取り込み、検索エンジン X! Tandem または MSFragger で検索を    

行ってその結果を Scaffold 5 上に表示させることができるようになりました。検索機能を利用したい場合、

予め各検索エンジンの実行ファイルの場所を Scaffold 上から指定する設定を行う必要があります。    

それぞれのプログラムをご利用の際にはライセンスについてよくご確認いただき、license agreement に

承諾される必要がありますのでご注意ください。また検索エンジンによって読み込み可能なファイル     

フォーマットが異なりますのでその点もご注意ください。 

 

検索可能なファイルフォーマット 

 X! Tandem : mzXML, MGF, DTA, PKL などのピークリストファイル 

 MSFragger : Thermofisher rawデータ、Bruker .d ディレクトリ、mzML などの rawファイル 

 

2-4-1. 実行する検索エンジンプログラムをセットする : X! Tandemの場合 

 

以前までのバージョンと異なり、現バージョンでは X! Tandem がバンドルされていません。利用する  

ためにはユーザーが X! Tandem をダウンロードして Scaffold と同じコンピューターにインストールする  

必要があります。 

 

X! Tandem URLは以下にガイドがあります。 

http://www.proteomesoftware.com/search-tools 

 

インストールした X! Tandemを Scaffoldで使用するため、以下の操作を行ってください。 

 

 

 

 

 

1. menuの Edit -> Preference 

2 「Path」タブの「Search Engines」で

X! Tandem を選択し、「Choose 」で  

検索エンジンプログラム(tandem.exe)

を選択 

http://www.proteomesoftware.com/search-tools
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2-4-2. 実行する検索エンジンプログラムをセットする : MSFraggerの場合 

 

MSFraggerを利用するためにはユーザーが MSFraggerをダウンロードしてScaffoldと同じコンピュータ

ーにインストールする必要があります。 

MSFragger URLは以下にガイドがあります。 

http://www.proteomesoftware.com/search-tools 

 

 

インストールした MSFraggerを Scaffold で使用するため、以下の操作を行ってください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2-4-3. MSFraggerまたは X!Tandemでの検索実施とデータ読み込み方法 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. menuの Edit -> Preference 

2 「Path」タブの「Search Engines」で

MSFragger を選択し、「Choose 」で  

検索エンジンの jarファイルを選択 

1. New ボタンを押し (または

Ctrl+N) 取り込みを開始します 

http://www.proteomesoftware.com/search-tools


30 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. 定 量 デ ー タ を 含 ん で い な い 場

合 、  ”Spectral Conting(Standard)” を  

選択します。続いて”Next”ボタンを押します。 

3. Sample Name、Category の欄を記入し

ます。複数ファイルを取り込みかつ結果を最初か

ら 結 合 さ せ た い 場 合 、 「 MuDPIT 

Experiment」にチェックを入れます。 

続いて「Next」ボタンを押します。 
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4. Queue Raw Data For Loadingを 

クリックします。 

5. 検索を行う raw ファイルまたはピーク  

リストファイルを選択します。 

6. 同サンプルとして読み込む結果ファイルが 

更にないか問われます。ない場合は画面下の

「Next」ボタンを押します。 
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7. 先程の指定とは別のサンプルとして読み込む

結果ファイルがないか問われます。ある場合は

「Add Another BioSample」ボタンをクリック

します。 

8. 2～6 の操作を繰り返します。今度は Sample 名

指定の際名称を変える事と、先ほどと異なる raw   

ファイル (ピークリストファイル)を選択する事に注意し

てください。 



33 
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10. 検索で利用したデータベース

を指定します。 
11. X!Tandem （または

MSFragger ） で 検 索 を  

追加で行うか、指定します。 

12. Scoring （ Validation  

含む）方法を指定します。 
13. タンパク質のグルー

プ化表示の有無を指定 

します。 

16. すべてのパラメータを選択後、”Load 

Data”ボタンを押すと、検索パラメータ入力画

面に遷移します。 

9.すべての dat,sample,Category の取り込みが終了

したら、「Add Another BioSample」ボタンをクリック

せず「Next」ボタンを押します。 

15. Gene Ontology や

Pathway アノテーション

の有無を指定します。 
14. 結果画面表示前に

FDRの計算を実施するか

指定します。 
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[X! Tandemの場合] 

 

以下のように検索を実行する際に与えるパラメータ入力画面が現れます。 

 

X! Tandem Database Options  

 

Include only identified proteins : 拡張検索実施のオプションだが、この画面では使用しません。 

Generate decoy proteins  : FDR計算を行うためのDecoyデータベース作成を行います。 

Accession Filter   : 文字列の条件検索で、taxonomyや特定遺伝子のみを対象とする 

時に利用します （”_HUMAN”などと利用します）。 

Precursor Tolerarnce  : Precursorの測定値と理論値の誤差 

Fragment Tolerance  : Fragmentの測定値と理論値の誤差 

Digestion Enzyme  : タンパク質配列から理論ペプチドを生成する際の切断パターン。 

Modification   : 修飾。Fixed(全アミノ酸置換)と Variable  

（置換する/しない を両方考慮） 

 

 

 

すべてのパラメータを選択後、”Load 

Data”ボタンを押すと、 データ取り込

み並びに検索が実行されます。 
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[MSFraggerの場合] 

 

以下のように検索を実行する際に与えるパラメータ入力画面が現れます。 

 

MSFragger Database Options  

 

Include only identified proteins : 拡張検索実施のオプションだが、この画面では使用しません。 

Generate decoy proteins  : FDR計算を行うためのDecoyデータベース作成を行います。 

Accession Filter   : 文字列の条件検索で、taxonomyや特定遺伝子のみを対象とする 

時に利用します （”_HUMAN”などと利用します）。 

Precursor Tolerarnce  : Precursorの測定値と理論値の誤差 

Fragment Tolerance  : Fragmentの測定値と理論値の誤差 

Digestion Enzyme  : タンパク質配列から理論ペプチドを生成する際の切断パターン。 

Modification   : 修飾。Fixed(全アミノ酸置換)と Variable  

（置換する/しない を両方考慮） 

 

すべてのパラメータを選択後、”Load 

Data”ボタンを押すと、 データ取り込

み並びに検索が実行されます。 
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2-5. 配列データベースの登録  

 

2-5-1. 概要 

 

 Scaffold に取り込む結果ファイルには、タンパク質の配列が含まれていません。同定タンパク質の

ID(Accession)情報を基に配列情報を取得し紐づけるため、Scaffold 上で検索に利用したものと同じ配列

データベースを取り込む必要があります。またFASTAデータベースのセットはScaffoldで検索結果を読み

込んだり検索を実行する前に行ったりする必要があります。Scaffold で取り込んだ FASTA ファイルは 

“Edit FASTA Databases”ダイアログで管理する事ができます。 

FASTAを取り込む際、FASTA先頭行の中でどの部位が Accession(ユニークな ID)となり、またどの部位

が Description(タンパク質の内容についての説明)にあたるのかを指定する必要がありますが、それを自

動的に行う設定もScaffoldには準備されています。ここでは配列データベースをScaffoldに取り込ませる

方法やその関連事項について説明しています。 

 

2-5-2. Ediｔ FASTA Databases ダイアログ 

 

・Menuの Edit -> Edit FASTA Databases  

・データ取り込みなど各所必要な時に現れる「Edit Databases」ボタン 

これら操作によりダイアログが現れます。 
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「Edit Databases」ダイアログでは登録されているデータベースの一覧、データベースの追加・変更・削除を

行う事ができます。 

 

 

 

 

2-5-3. FASTAデータベースの登録方法 

 

1. 2-5-2 で案内している方法で、「Edit Databases」ダイアログを開きます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. 「Add Database」ボタンを押します。 
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4. データベースの ID,Description

に関する抜出ルールを設定します。  

特にこだわりがないかぎり、「Auto 

Parse」を選んでください。 

3. データベースファイルを選択し、

「開く」を押します。 

5 データベースの取り込みが開始します。収容

後、取り込まれたデータベースが一覧に表示され

ます。確認後「OK」を押してください。 
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2-5-4. parse ruleについて（Configure Database Parser） 

 

2-5-3 の parse rule に関する補足説明をいたします。 

FASTAの先頭行の情報から、Accession (データベースのユニークな ID)と Description (説明部分の記

述)の箇所を認識し、各エントリーデータの特性とします。この時、Accessionや Description の部位を認識

するためのルール、文法のようなものが「parse rule」です。「正規表現」と呼ばれるようなルールを使って

定義します。Accession については、結果ファイルに含まれている内容と Scaffold 上で指定した内容が  

一致している必要があります。 

 

Parse rule は 2-5-3 でも説明したように、通常は”Auto Parse”を選択すれば問題ありません。しかし 

検索エンジン側で使用していた parse ruleと、Scaffold auto parse で指定した parse ruleが一致して

いない場合は調整する必要があります。一致しないと Scaffold で取り込んだのち各タンパク質の配列の 

紐づけがうまくいかず、配列や分子量などの表示が正しく行われません。 

ご自身で最適な parse rule を指定したい場合、FASTA ファイル設定時の途中、「Parsing Method」  

選択時に、「Use Regular Expressions」ボタンを押します（下図）。 

 

 

 

 

 

 

 

 

 

 

 

 

予め準備されている parse rule から最適なも

のを選び、「Apply」ボタンを押してください。 
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3. Samples View 

 

 

3-1. 概要  

 

Scaffold では各種機能を持つ View（画面）があり、左側にそれらの View を切り替えるためのスイッチが 

あります。 

 データを取り込み後、最初に表示されるのが「Samples」Viewです。 

各サンプル別の同定タンパク質やアサインされたペプチドの数、同定されたタンパク質の Gene 

Ontology 情報を一覧で表示する画面です。Scaffold のデータ検証は主にこの Samples View で行い  

ます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3章では Samples View について、その見方・使い方を説明いたします。 

英文マニュアルの「Chapter.6 Sample View」に該当する内容です。 

 

3-2 . Samples View画面・表示内容 

 

Samples view ではサンプル毎に、同定タンパク質／アサインされたペプチドの数／Gene Ontology な

どの情報を表示しています。以降、表示内容について説明いたします。 
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[全体図] 

 

下図内の番号（①など）が、以降の説明の小項目 (「3-2-1」など)と連動しています。 

 

 

 

 

 

 

 

 

 

 

以降、各項目について説明をしていきます。 

 

3-2-1. Display pane: Samples  table で表示する数値の設定 

 

各サンプルの列で表示される数字について、表示内容を切り替えます。主に、同定の確からしさや定量に関

連する数値を評価できる数値を選択する事ができます。 

 

Display Options の選択項目は次頁表の通りです。 

 

 

 

 

 

① The Display pane : 

samples tableで表示する数値の設定 

② Filtering Samples 

表示タンパク質/ペプチドの絞り込み条件 

③The Samples Table 

同定タンパク質に関する情報を表示 

④ Information Panes 

類似タンパク質情報、GO情報など 
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項目 説明 

Protein Identification Probability タンパク質の同定確率。タンパク質にアサインされたペプチドの同定

確率(Peptide prophet) を基に Protein Prophet で計算 されま

す。 

Percent Coverage タンパク質全長（残基数）に対し、アサインされたペプチドの残基数

の割合。 

Percentage of Total Spectra サンプル内全スペクトルに対して、タンパク質にアサインされたスペ

クトルの数の割合。 

Exclusive Unique Peptide Count 

下記説明文参照。用語の構成として、 

最初 : Exclusive か Total  

その後ろに  

Unique peptide / Unique spectrum / Spectrum  

Countという形式となっています。 

Total Unique Peptide Count 

Exclusive Unique Spectrum 

Count 

Total Unique Spectrum Count 

Exclusive Spectrum Count 

Total Spectrum Count 

Quantitative Value Total Spectrum Countを、各サンプルの全同定スペクトル数を元

に Normalize した指標値。表示内容を別の定量指標に変更可能

（Experiment -> Quantitative Analysis の      「Use 

Normalization」->「Quantitative Method」） 

 

説明補足: 

 

■ Exclusive と Total 

 

・Exclusive は、該当タンパク質（グループ）のみに存在するペプチド／スペクトル。それに対し Total は、

Exclusive に加え他のグループ【類似タンパク質群】でもアサインされているペプチド／スペクトルを加え

た数となります。従って、数は  

Total ≧ Exclusive となります。 

 

■ Unique peptides / Unique spectra / Spectrum 

 

 Scaffold の用語において「Unique」は、他の同定タンパク質と共通してアサインされているペプチドで

あるかどうかは一切関係ありません。同じ配列にマッチしている複数のスペクトルについて、１つにまとめ

て１つと数え上げるか、それともばらばらのままで数え上げるかの違いです。３つの項目は次頁のような 

違いがあります。 

 

・Unique Peptides 

タンパク質にアサインされたペプチド数。修飾のあるなしに関わらず、また電荷の相違に関わらず、同一

配列のペプチドは１つとして数えます。 
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・Unique Spectra 

Unique peptidesと似ていますが、修飾が異なる場合や電荷が異なる場合は別のものとして数えます。 

 

・Spectrum 

同一ペプチド配列として同定されたスペクトルすべてを１つにまとめずバラバラに数えます。 

 

従って数は 

Spectrum ≧Unique Spectra ≧Unique Peptides となります。 

 

 

「 Req Mods 」： 

特定の修飾基がついているペプチドのみを表示するためのフィルター 

 

「 Search 」： 

すべてのタンパク質 / ペプチド データを対象としたキーワード検索で検索条件に該当するタンパク質／

ペプチド のみを表示するためのフィルター。入力欄にキーワードを入れて検索する単純検索のほか、虫眼

鏡アイコンをクリックすると現れる詳細検索画面があります（下図）。 
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3-2-2. Filtering Samples: 表示たんぱく質/ペプチドの絞り込み 

 

 

[Protein Threshold] 

タンパク質の同定確率（Protein Identification Probability）、または Protein FDR による表示    

タンパク質の絞込みができます。同定確率は アルゴリズムProtein Prophetにより計算される数値です。

Protein FDR は%の後ろに「FDR」とついている項目（下図）で、decoyデータベースに対する検索を   

行った時のみ現れます。（Protein FDRの計算方法は少し特殊です。英文マニュアルをご参照ください） 

 

 

 

 

 

 

 

 

 

[Min # Peptides] 

タンパク質にアサインされた同定ペプチド数の最低数値を指定できます。1～5 までの数値を設定    

できます。 

 

[Peptide threshold] 

ペプチドの同定確率 (Peptide Identification Probability）または FDRのパーセントによる表示    

ペプチドの絞込みができます。数値はアルゴリズム LFDR(local False Discovery Rate)またはPeptide 

Prophet により計算されます。ここで定義した閾値の基準を上回るペプチドのみが、タンパク質の同定や

Display options などで表示されるペプチドの数、Coverage の数値計算に使われます。 

同定基準は、予め提示されている選択肢の他、「Custom」を選択する事でユーザーが独自に設定をする

ことができます。Custom を選択した場合、Protein Threshold の基準は使用できなくなります。 
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“Custom”では様々な条件を指定する事ができます。 

 

- Peptide Probability (最初から入っていますがゴミ箱アイコンをクリックして消す事ができます) 

- 電荷 

- Precursor の誤差 

- ペプチドの長さ 

- 修飾の種類 

- Missed Cleavage数 

- 各検索エンジンから得られるパラメータ [スコアなど] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

複数の条件を組み合わせて作成する事も可能です。 
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3-2-3. The Samples Table: 同定タンパク質に関する情報の表示 

 

Samples Tableでは各サンプルで同定されたタンパク質の情報が表示されます。 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

タンパク質名,Accession,Taxonomy 

A 

Gene Ontology  

ペプチド数など 

タンパク質名 

タンパク質総数 

Accession 分子量 生物種 

Gene Ontology  

Biological Process 

Gene Ontology  

Cellular Compartment 

Gene Ontology  

Molecular Function 

検索し該当した GO 

情報には●を表示 

各 サ ン プ ル の 同 定  

ペプチド数などを表示 

Bio View  又は

MS/MS View  
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Samples Viewでの表示は、アイコンの BioSample View / MS Sample View ボタンの切り替えによ

って内容を変更することができます（下図）。 

 

 

 

 

 

 

 

 

BioSample View では、予め定義された BioSample 単位にデータがまとめられます。一方 MS 

Sample Viewを選ぶと、まとめられていた MS Sample が展開して表示されるようになります（下図） 
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また、表内の各列をクリックすると、その項目での降順／昇順／並び替え解除 にて各列を並び替えるこ

とができます。 

 

 

 

 

 

 

 

 

 

 

 

 

3-2-4. Information Panes:タンパク質・サンプルに関する追加情報 

 

  画面下部には Samples table とは異なる情報を表示する Information Panesがあります（下図）。 

 左から順に、「Protein Information pane」「Annotation pane」「Sample Information pane」から

構成されています。 

 

 

 

Protein Information pane 

左下の「Protein Information pane」では、選択しているタンパク質について、ファミリー（Scaffoldでは、

MASCOTでいう subsetと samesetに該当する）タンパク質の IDが並んで表示されます   （下図）。ま

た「Lookup Accession Number In」で接続先のサイトを選択してからボタンを押すと、該当サイトにおけ

るエントリー情報をブラウザで表示させることができます。 
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Annotation pane 

 

真ん中下の「Gene Ontology pane」では、選択しているタンパク質の Gene Ontology階層構造の情報

が表示されます（下図）。気になるGOに関して選択しダブルクリックすると、Gene Ontologyの用語説明の

ページがWEBブラウザで開きます。 

 

 

  Sample Information pane 

 

画面右下は、Sampleに関する情報を表示する「Sample Information pane」です。sample table内で、

各 sample(Biosampleまたは MS Sample)の列の何かの項目を選択すると、その sampleに関する情報

が表示されます（下図）。 

 

 

3-3 . FDRダッシュボード・オプションインジケーターランプ 

 

画面一番左側の下に、FDR の計算内容に関する表示と、表示に関するオプション

で何が選択されているかを一目で判別するインジケーターがついています（右図）。 

 

 

FDR ダッシュボードには、同定基準を超えるタンパク質数、スペクトル数並びに
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それぞれのフィルターリング条件が表示されます。 

解析対象の検索が Decoyデータベースに対しての検索も行い FDRの計算ができる時、ダッシュボードの

色が赤（下図左）になります。decoyの計算をしていない場合、青色（下図右）となります。 

 

 

 

 

 

 

FDR ダッシュボードの下にある６つの〇は、表示のオプション選択状況のオン/オフを緑丸/黒丸で表し

ています（下図）。各丸の内容は左から順に以下の内容です。丸にカーソルを合わせると説明が  表示され

ます。 

- Show less <5% probability 

- Show lower Scoring Matches 

- Show entire protein Clusters 

- Use Protein Cluster Analysis 

- Use Independent Sample Grouping strategy 

- Scoring Scheme  (LFDR:緑, Peptide Prophet Advanced : オレンジ、 

Peptide Prophet:黒) 

 

インジケーターの上にカーソルを合わせる事で、選択内容を文字で確認する事ができます。なお上記  

リストの上の３項目は、 Menuの View にて設定内容を切り替える事が可能です。 

 

 

3-4 . Probabilityの凡例 

 

MS Sample 並びに BioSample の各セルについている色は、Sample画面の表左上にあるタンパク質

の同定確率(Probability)に基づいています（下図）。タンパク質の同定確率は、Protein Prophet によって

計算された数値です。 
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4. Menuの各項目について 

 

 この章では、Scaffold のメニュー選択内容と各項目で設定できる内容について説明しています。最初に

一通り説明し、それ以降の項目で各選択項目の中でより詳しい解説が必要な情報についてピックアップ  

しています。 

 

4-1. menuの内容 説明  

メニュー コマンド 

File 

 

 

・New - ファイル作成ウィザードを起動します。詳細は 2章「MASCOT

結果取り込み」をご覧ください。 

・Open - Scaffoldのファイル（.sf3）を開きます。 

・Merge – Scaffold 上で  .sf3 ファイルを統合します。詳細は

「4-3.sf3ファイルの統合(merge)」をご覧ください。 

・Close - 今開いている sf3ファイルを閉じます 

・Save - 今開いている sf3ファイルを保存します 

・Save As - 今開いている sf3ファイルを別名で保存します。 

・Save Condensed Data - 今開いている sf3ファイルを、保存  対

象を変更しながら別名保存します。詳細は「4-4.データサイズ  間引き

方法」をご覧ください。 

・Print – 現在開いている view 画面を印刷します。 

・Print Preview – 印刷の preview を表示します。 

・Exit – Scaffold を終了します。 

Edit 

 

 

・Copy – 選択時に開いている view のデータをそのままクリップボ

ードにコピーします。タブ区切りのデータとなります。 

・Find – 検索用のダイアログを開き viewから該当項目を探します。 

・Edit FASTA Database - FASTAデータベースを追加します。詳細

は「2-4. 配列データベースの登録」をご覧ください。 

・Edit Peptide Threshold - ペプチドの閾値を設定します。詳細は

「3-2-2. Filtering Samples」内の Peptide Threshold 項目をご覧く

ださい。 

・Edit Annotation Options–GO に関する設定画面を開きます。詳

細は「4-5.GOの設定」をご覧ください。 

・Bulk Operation – [Samples viewのみ] 選択項目をまとめて設定

変更します。 

・Preferences – Scaffold の設定変更。詳細は「4-6.Preferences 設

定」をご覧ください。 

・ Advanced Preferences – Scaffold の設定変更 。 詳細 は

「4-7.Advanced Preferences」をご覧ください。 
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メニュー コマンド 

View 

 

 

・Navigation Pane – View切り替えパネル(画面左側) 表示/非表示  

・Switch Sample View – BioSample / MS Sample 表示切替 

・Switch Display Options – Display Options を切替。詳細は

「3-2-1.Display options」をご覧ください。 

・Show Entire Protein Clusters – タンパク質のクラスターに  含

まれる、Protein probability が設定基準値以下のメンバー       タ

ンパク質について表示/非表示 するかの切替 

・Show Lower Scoring Matches -Protein probability が設定   

基準値以下の場合に display option で定められた数値を各サンプル

のセルに表示/非表示 するかの切替 

・Show  < 5% Probabilities – Peptide Probability のとても   低

いペプチドについて 表示/非表示 するかの切替 

・Show Sample Notes – Samples画面下段の「Information pane」

について 表示/非表示 するかの切替 

・Show Hidden Annotations – Hiddenと定義したタンパク質の表

示/非表示 するかの切替 

・Navigate – 画面内にタブがある view 内の pane について、選択タ

ブを切替 

 

Experiment 

 

 

 

 

 

 

 

 

 

 

 

・Edit Experiment – 選択中の MS Sample(experiment)に   つ

いて、名称などを設定するダイアログが現れます 

・Edit BioSample – 選択中の BioSample の編集。「Load Data」

view→sample タブ選択右クリック→「Edit BioSample」と同じ  操

作（ダイアログ出現） 

・Add BioSample – BioSampleを追加。「Load Data」view→ 「Add 

BioSample」と同じ操作（ダイアログ出現） 

・Delete BioSample – BioSample を削除。「Load Data」view→

BioSample のタブ選択右クリック→「Delete BioSample」と同じ操作

（ダイアログ出現） 

・Queue Files For Loading – Experimentを追加。「Load Data」

view→「Queue Files For Loading」と同じ操作（ダイアログ出現） 

・Queue Files From Mascot Server For Loading – １つ上の  

「Queue Files for Loading」コマンドと似ていますが、datファイルを

MASCOT Serverのログから選択しネットワーク経由で取得。 

・Queue Structured Directories For Loading – 2 つ上の

「Queue Files for Loading」と似ていますが、取得対象がファイルでな

くフォルダ内のファイル群である場合に使用。「Load Data」 view→

「Queue Structured Directories」と同じ操作（ダイアログ出現） 
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メニュー コマンド 

Experiment 続き 

 

・Apply New Database – データベースの追加。詳しくは   「2-4.

配列データベースの登録」を参照してください。 

・Extract Alternate IDs – 検索時の「Accession」とは別に   定め

られた ID に関する設定。Pathway など外部データベースとの連携の

際に使用する IDの抜き出しルールを選択します。 

・Apply Protein Annotation Preferences - 類似タンパク質   グ

ループの中で、どのタンパク質を代表として選択し表示するかに関す

る設定。正規表現で設定します。 

・Load and Analyze Queue - 「Load Data」Viewにて Experiment 

と BioSample の紐づけが完了しているものの、Experiment の  取

り込みが未完了な状態の場合、取り込みを開始します。 

・Reset Peptide Validation – 主に Proteins View で、手動で  

変更した peptide valid チェック（同定ペプチドとして認識する/ しな

い の切り替え）をリセットします。 

・Add or Edit Annotations – GOまたは Pathway情報の付与に関

する設定を行います。詳しくは「4-5. GO の設定」、並びに 「4-8. 

Pathwayの設定」をご覧ください。 

・Quantitative Analysis – 定量解析（検定）を行います。詳細は 11

章の「定量手法と検定」をご覧ください。 

 

Export 

 

 

・Subset Database – 結果に出てきたタンパク質のうち特定の条件

を満たすタンパク質のみを fastaフォーマットで出力します。 

・Spectra – 特定の条件を満たす ピークリストを出力します。 

・BLIB – blib フォーマットで同定結果の中かピークリストを出力しま

す。skylineや Scaffold DIA などでで使用可能です。 

・ProtXML – protXML フォーマットで解析結果を出力します 

・mzIdentML – mzIdentMLフォーマットで解析結果を出力します 

・SFDB  – Scaffold PerSPECtives（別売） フォーマットでファイルを

保存します。 

・Scaffold Batch / 

・Scaffold Batch Archive 

 ともに Scaffold Batch(別売)で使用するフォーマットファイルを保存

します。 

 

[次頁に続く] 
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メニュー コマンド 

Export 続き 

  

以降は Excelで開く事ができる CSVフォーマットでの出力です 

 

・Publication Report – Publish view で表示される内容と同じ情

報・Samples Reports – Samples viewで表示される内容と同じ情

報で出力します。出力時に、表示する数字を Display optionから選択

できるほか、sameset/subset のタンパク質も併せて出力するかを選

ぶことができます。 

・Spectrum Reports – 検索結果をスペクトル単位で出力します。

Spectrum の数字をそのまま出力するか、定量指標を出力するか選ぶ

ことができます。 

・Peptide Reports – 検索結果をペプチド単位で出力します。

Protein Viewの Peptide pane のデータ一覧に該当します。 

・Protein Reports – 検索結果をタンパク質単位で出力。Protein 

Viewの Protein paneのデータ一覧 に該当します。 

・PSEA-Quant Report – PSEA-Quant解析(同定タンパク質につい

て機能別のグループ化を行う解析)のレポートを出力します。  

・Current View – 現在みている View の情報を出力（＊View によ

っては選択できません） 

・Complete - 様々な解析データをまとめてフォルダに出力します。 

- sample画面の display optionを変えたパターンで出力 

- タンパク質毎に Peptide Reportと同内容の情報が出力 

 

Quant 

 

 

（「Q+」または「Q+S」モジュール購入時で該当データを読み込み時のみ

選択可能） 

 

・Launch Q+ Quantitation Browser – Q+モジュールを起動 

・Edit Quantitative Method / Purity Correction – 定量解析に

関連する値の補正に関する設定 

 

Window 

 

・Emphasize – 選択中の viewが複数の panelから構成される時、大

きく表示したい箇所を emphasizeで選択してください。 

 

・view名 - view名と同じ項目を選択する事で View 画面の切り替え

ができます。画面左側「Navigation pane」で各 View のパネルをクリ

ックするのと同じです。（表示されているショートカットキーでも画面を

切り替える事ができます。） 
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メニュー コマンド 

Help 

 

 

・Help on Current View – 現在開いている viewに関して online 

help画面が開きます。 

・ Help Contents – online help が開きます。 

・ Scaffold User’s Guide – PDFの Scaffold マニュアルが開きま

す。 

・Scaffold Q+ User’s Guide – PDFの Scaffold Q+マニュアルが開

きます。 

・Open Demo Files- 予め準備されている demoファイルを開く事が

できます。 

・Scaffold FAQs/Resource Center – Proteome Software社のサ

イトにある FAQや tutorial 用の Resourceにアクセスできます。 

・Show Log Files – errorlog, output log が格納されているフォル

ダを開きます。 

・Referencing Scaffold – Scaffold 関連の reference (論文)に関す

る情報にアクセスできます。 

・Upgrade License Key – license を再入力できます。 

・About Scaffold – Scaffold のバージョンや、コピーライトに関する

情報などにアクセスできます。 

 

IdentityE 

 

 

・Quantitation Options – identityE に関するオプションを指定 

・Export IdentityE report – IdentityE のレポート同様、解析対象

ペプチド情報のタブ区切りデータを出力します。 

 

 

4-2. ファイル保存方法・ファイルを開く方法  

 

File -> Save （又は Ctrl キー + S）でファイルを保存できます。Scaffold ファイルの拡張子は「sf3」です。 
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OSが日本語環境の場合ファイルできるだけデスクトップ上でなく別の場所に置くようにしてください。 

保存したファイルを開くには、File -> Open (Ctrl + O)とします。旧バージョンのファイル（拡張子 sfd）を 

開く場合、フォーマット変換の過程が入るので多少時間がかかります。ご注意ください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4-3. sf3ファイルの統合 (File ->merge)  

 別々に作成された  sf3 ファイルを、Scaffold   

上で統合する事ができます。 

統合する時はまず一方の sf3ファイルを Scaffold 

上で開きます。File -> merge とするとファイル 選

択画面になるので、もう一方の sf3  ファイルを選

択します。すると右図のような Merge 操作のダイ

アログが現れます。ダイアログの「Merge」ボタンを

押すとファイルの統合が   行われます。 

 

 

なお、Merge の逆、すなわちデータから一部のデータを削除するのは「Load Data」view から行います。

詳細は「5-3.BioSample tabと Load and Analyze Queue button」をご覧ください。 
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4-4. sf3ファイルのデータサイズを削減する方法  

 

Scaffold で読み込む dat ファイルのサイズが大きく処理が遅くなったりできなくなる場合、sf3ファイル

が内部に持っているMS/MS のスペクトルデータを捨て、sf3ファイル全体のサイズを小さくする事で対処

できます。 

＊ ここで指定する操作でファイルを保存すると、データが完全に捨てられてしまい元の状態に戻す事が

できません。試す場合などは必ずファイルのバックアップを取ってから行ってください。 

 

File -> Save condensed data と選択すると、選択肢のダイアログが現れます（下図）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

選択肢の内容は以下の通りです。なお、「Frozen」とついているものは、ついていないものに加えて     

ファイル情報を内部で圧縮しており、ファイルサイズはより小さくなりますが処理は遅くなります。 

 

・Save Only Identified Spectra 

・Save Frozen Identified Spectra 

  同定基準を超えるスコアを持つデータのみスペクトルデータを保存し残りのデータは破棄します。 

 

・Save Without Any Spectra 

・Save Frozen Without Any Spectra 

同定基準を超えるものも含め、すべてのスペクトルデータを破棄します。各ペプチドの配列や  スコア

に関する情報は残ります。 

 

・Save MCP Required Spectra 

・Save Frozen MCP Required Spectra 

MCPで提出が求められる基準に基づいたもので、基本的には Only Identified Spectraと同じです。 
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 処理によりファイルサイズが減少します。目安として、「Only Identified Spectra」が元データの 50%、

「Without Any Spectra」が元データの 90%を削除します。また Frozen の圧縮では 1/2～ 1/3 と

なります。 

ある解析例では以下のようにファイルサイズが縮小されます。 

 

項目 ファイルサイズ 

元のデータ 1,337,646 KB 

Only Identified Spectra 457,167 KB 

Without any spectra 79,657 KB 

Save MCP Required Spectra 457,134 KB 

Frozen Save only Identified 

Spectra 

212,247 KB 

Frozen Without Any Spectra 36,271 KB 

 

4-5. GOの設定  

 

Scaffold の Samples ウィンドウで Gene Ontology の情報を表示させる事ができます。Gene 

Ontology の情報は NCBI から取得することができるほか、EBI にて公開されている Gene Ontology 

Annotation Database ファイルを Scaffoldがインストールされている PCにダウンロードし、その ファイ

ルから取得する方法もあります。ローカルのファイルをいったんセットすると、インターネットを介した取得

より短時間で情報を取得できるほか、インターネット接続がない／回線速度が遅い 環境でも問題なく利用

できます。以降、「GOAファイルのセット」「表示するGOの設定」「GO情報を付与、表示する方法」について

ご案内します。 

 

 

4-5-1. GOAファイルのセット 

 

Gene Ontology Annotation Database を Scaffold にセットする方法について記します。操作は GO

のファイルが自動で取得できる場合と、自動取得を試みた結果何らかの理由で操作が完了しない場合にフ

ァイルを別途取得してセットする場合の 2種類をご案内いたします。 

 

 

 

 

[次頁に続きます] 
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[ファイル取得を自動で行う場合] 

 

Edit -> 「Edit Annotation Options」 -> 「GO Annotation Database」にて「Add」ボタンを押します。現

れるダイアログの「Source」項目で使用予定の生物種を選択し、「Add」ボタンを押します。（下図） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2「GO Annotation Databases」タブ内の、

「Add」をクリックします。 

3. Source で GO 情報を表示させたい生物種を選択し、

「Add」ボタンを押します。以降、ファイルのダウン  

ロード、解凍、Scafold 用ファイルフォーマットへの 

変換、が自動的に行われます。 

＊「All Proteomes」の場合、すべての生物種に対応  

しますがファイルサイズが大きく表示にも時間が   

かかりますのでご注意ください。 

1.Edit -> Edit Annotation Options 

を選びます。 
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[ファイルを別途準備してセットする場合] 

 

前述の [ファイル取得を自動で行う場合] にて、ファイル取得が一定時間内に終わらなかったなど何らかの

理由で実行完了しなかった場合、ファイル取得を別途行ってそのファイルを読み込むことで問題を回避でき

ることがあります。 

Edit -> 「Edit GO Term Options」 -> 「GO Annotation Database」にて使用予定の生物種を選択し、

「Add」ボタンを押します（下図）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2「GO Annotation Databases」タブ内の、

「Add」をクリックします。 

1.Edit -> Edit Annotation Options 

を選びます。 

3. Sourceで「Other File」を選択します。ファイル選

択ダイアログが現れるので該当ファイルを選択し、「開

く」を押すと GOAファイルが追加されます。 
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4-5-2. 表示する GO情報の設定 

 

GOは「Biological process」「Cellular component」「Molecular function」の３つについて、それぞれ

階層構造で構成されています。Scaffold ではGO情報を表示させることができますが、どの階層のどの項

目について表示するかは以下 2つの選択肢があります。 

- PSEA-Quant を適用し得られた Gene Ontology を適用 

- 自身で選択 

 

ここでは表示内容に関する設定方法をご案内します。 

 

[設定画面の表示] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.Experiment -> Add or Edit 

Annotations を選びます。 

2.Annotation Sourceで GO Terms 

を選択します。続けて、GO の表示

項目を選択します (以下続きます) 
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[a.Automatically select with a PSEA-Quant analysis を選択する場合] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3a.「Automatically select with a 

PSEA-Quant analysis」を選択し、

「OK」ボタンを押します 

4a. 自動的に、表示に最適な GO グル

ープを選択する  「 PSEA-Quant 

analysis」実行に関するパラメータを

選択します。設定後、「Apply」ボタン

を押すと設定が適用され、設定に合わ

せた GO情報が表示されます。 

 

＊このプログラムは本来定量解析との

結びつける目的で開発されたもので

す。今回の選択肢でも Quantitative 

Value と結び付けた Report 出力に 

関するオプションを選択する事が  

出来ます。 
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[b.Manual Selectを選択する場合:表示項目を増やす操作] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4b. 上段の GO 情報で加えたい項目を階層構

造を展開しながら探し出し、選択した状態で

「Add」ボタンを押します。 

3b.「Manually select」を選択し、

「OK」ボタンを押します 
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[Manual Selectを選択する場合:表示項目を減らす操作] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5b. 下段の表示リストに該当項目が加わります。 

6b.下段のGO情報で削除したい項目を選択し

「Remove」ボタンを押します。 

7b. 下段の表示リストから該当項目が削除されます。 
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4-6. Preferencesの設定内容  

 

Scaffold 動作に関する設定が集まっている「Preferences」ダイアログは、メニューの    「Edit」→

「Preferences」と選択する事で開く事ができます。Preferences ダイアログには、以下の計９つのタブから

構成されています。 

「Internet」「Memory」「Procesors」「Web Link」「Mascot Server」「Display Settings」「Password」

「Paths Settings」「MZID」 

 

 

以下、各タブで設定できることについて説明して

います。 

 

 

□ Internet 

Internet 接続する/しない、Proxy サーバーの  

設定を行う事ができます（右図）。 

 

 

□ Memory 

Scaffold で使用する事ができる Memory の最大値を設定する事ができます。Scaffold の動作が遅い時、

設定値を上げる事で改善される事があります。設定変更の内容を反映させるためには、Scaffold    ソフ

トウェアの再起動を行う必要があります。 

 

□ Processors 

 Scaffold で使用するコア数を指定する事ができます。ただし Scaffold 自体は使用可能なスレッド上限は

２で、それ以上の設定は X!Tandemの検索時にのみ有効です。 

 

□ Web Link 

Samples Viewの画面下部、Protein Information 

（下図、右図）で表示されるタンパク質データベース 

へのリンクに関する設定ができます。 
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□ Mascot Server 

logファイルを参照するMASCOT Server に  関

する設定を行う事ができます。 

 

□ Display Settings 

 利用できる View を選択する事ができます（右図）。

チェックを外すと画面左の Navigation pane から

消え、さらに menu の Window でも選択する事が

できなくなります。 

またデータ取り込みやファイルオープン時に最初に

開く Viewに関する設定も行う事ができます。 

 

 

□ Password 

ファイル単位で各種操作にパスワードを設定し、パ

スワードを入力しないと幾つかの操作ができない

ようにします（右図）。設定に関する各項目に つい

ての説明は以下の通りです。 

 

- Use Password 

パスワード使用の ON/OFF 、並びにパスワ

ードを設定します。 

- Protect Exporting Spectra 

スペクトルを出力する際パスワードを要求し

ます。 

- Protect Resetting Thresholds 

Threshold を変更する際パスワードを要求します。 

- Protect Changing Display Settings 

表示 View画面の変更をする際にパスワードを要求します。 

- Protect Hidden Proteins 

Hidden protein の設定を変更する際にパスワードを要求します。 

 

□ Path 

 修飾設定で利用しているファイル unimod に関する設定を行います。 

- Do not use UNIMOD 

結果ファイルに入っている修飾に関する情報をそのまま利用します。 

- Use Scaffold default UNIMOD 

Scaffold が自身で持っている UNIMOD ファイルを利用します。 

- Use a custom UNIMOD file 

ユーザーが準備した UNIMOD ファイルを利用します。 
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□ MZID 

 MZID にタンパク質の配列情報が含まれている場合、MZID に含まれている方のタンパク質配列を   優

先して使用するように設定する事ができます。 

 

4-7. Advanced Preferencesの設定内容  

 

Scaffold が結果検証のアルゴリズムで使う検索エンジンのスコアについて定義する事ができます。  設

定内容により同定基準に変動があり、結果も変わってきます。SequestとMASCOT用の設定がありますが、

Sequest(Proteome Discoverer) 用の設定はバージョンが 1.2より古い場合のみ適用を検討するもので、

多くの人は当てはまりません。 

 

[Sequest] 

バージョンが 1.2 より古い場合、以下の資料をご参照の上設定値を検討してください。ver.1.3 以上の場

合、設定画面にあるように最適な設定を「Auto-Detect」します。 

 

・PDF(英文) マニュアル 

Chapter.4 Scaffold’s Main Window -> Advanced Preferences -> Sequest tab 

・Online help 

Main menu component ->Advanced Preferences -> Sequest tab 

 

[MASCOT] 

 

「Ion – Identity Scoringも利用」するか「Ion Scoreのみ使用」するかを選択することができます。 

設定は、MASCOTから来た結果か、Proteome Discoverer から来た結果かでさらに分かれています。 
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4-8. Pathwayに関する設定  

Scaffold の Samples ウィンドウで Pathway の情報を表示させる事ができます。Pathway の情報は

「Wikipathways」または「Reactome」サイト から取得する事ができます。以降、「データベースの使用条件

（タンパク質 ID）」、「適用の実施方法」「お勧めの Pathway情報表示」についてご案内します。 

 

4-8-1. Wikipathways,Reactomeと使用時のタンパク質 IDについて 

 

WikiPathways, Reactome はそれぞれ反応パスウェイについてまとめられたデータベース[サイト]です。

詳細は以下情報をご参照ください。 

 

Wikipathways 

Kelder T, Pico AR, Hanspers K, van Iersel MP, Evelo C, Conklin BR. (2009) Mining Biological 

Pathways Using WikiPathways Web Services. PLoS ONE 4(7) 

 

Reactome 

 Fabregat et al. 2017 PMID: 28249561 

 

Wikipathways を利用するためには、「gene name」情報が必要です。Scaffold にて gene name は

FASTAファイル内の情報、または NCBIのサイトから取得します。gene name情報の取得並びに表示させ

るには、「Experiment」->「 Extract Alternate IDs」を実施する必要があります。 

 

一方、 Reactome データベースを利用する際も  Uniprot の Accession (例 :P02769 な

ど。’ALBU_BOVIN などの表記ではない)情報が必要となります。そのため、Reactome 使用を前提とする

場合、検索時から Accession (P02769 など)が ID となっているデータベースに対する検索結果を

Scaffoldに取り込むように注意してください。 

 

4-8-2. Pathway情報の表示 [Scaffold上] 

 

Pathwayに関する情報をScaffold のSamples 画面で表示させる事ができます。ただしScaffold上では

該当タンパク質が含まれる Pathwayの種類が表示されるのみです。タンパク質が含まれる Pathway 一覧

や、特定 Pathway の全体図とその中で該当タンパク質が占める位置の確認については、外部サイトの情報

を確認する必要があります。外部サイトの参照については、「4-8-3. Pathway情報の表示 [外部サイト]」を

ご参照ください。 

 

次頁以降、Scaffold 上で Pathway情報を表示させる操作方法についてご案内しています。 
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[設定画面の表示] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.Experiment -> Add or Edit 

Annotations を選びます。 

2.Annotation Source で「Pathways」

を選択します。 
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[a.Automatically select with a PSEA-Quant analysis を選択する場合] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3a.「Automatically select with a 

PSEA-Quant analysis」を選択し、

「OK」ボタンを押します 

4a. 自動的に、表示に最適な Pathway

グループを選択する 「PSEA-Quant 

analysis」実行に関するパラメータを

選択します。設定後、「Apply」ボタン

を押します。 

5a. 続けて PSEA_Qiamt Report の

出力場所とファイル名が問われ、入

力・決定します。 

Pathway情報が表示されます。 
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[b.Manual Selectを選択する場合:表示項目を増やす操作] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6a. Pathway情報が表示されます。 

3b.「Manually select」を選択し、

「OK」ボタンを押します 
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4b. 表示させたい Pathway 項目を 

手動で選択し、チェックを入れます。 

必要に応じてダイアログ下部にある

検索ウィンドウなどを使用します。 

すべて選択後、「OK」ボタンを押しま

す。 

5b. Pathway情報が表示されます。 
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4-8-3. Pathway情報の表示 [外部サイト] 

 

Scaffold 上では各タンパク質が含まれる Pathway 情報が表示されるのみにとどまります。Pathway の 

詳細情報については、公開元の WikiPathways または Reactome サイト上で確認することになります。 

両サイトへのリンクは Scaffold の Samples 画面下部、「Protein Information」pane と「Annotation」

pane にあります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

左側の「Protein Information」にある gene name (またはAccession)ボタンをクリックすると、該当タンパ

ク質でサイト上にて検索した Pathway一覧が表示されます（下図）。 
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また真ん中の「Annotaion」paneには、検索項目でマッチしたPathwayの項目リストがあり、それぞれの

ハイパーリンクをクリックすると該当 Pathwayが表示されます。 

Pathwayの中で該当タンパク質がどの位置に存在するかについては、表示されたWEBページ内の検索で

該当タンパク質名を探してください。 

 

 

 

 

「Protein Information」または「Annotation」 pane についての詳細は、「3-2-4.  Information Panes:

タンパク質・サンプルに関する追加情報」も併せてご確認ください。 

 

 

 

[次頁に続く] 

 

 

 

 

 

ペ ー ジ 内 で 該 当  

タンパク質を検索 

タ ン パ ク 質 が   

強調表示される 
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4-9. ツールバーアイコン  

 

使用頻度が高い項目については、画面左上にアイコンが準備されています。ほとんどのアイコンは    

メニューに同じ項目があります。 

 

アイコン 説明 

 ・New - ファイル作成ウィザードを起動します。詳細は 2章「MASCOT結果取り込み」をご覧

ください。 

 

・Bach Job Queue Dialog – Scaffold Batch の実行ダイアログを表示。このアイコンは

Scaffold Batchのライセンス購入時のみ表示されます。 

 ・Open - Scaffoldのファイル（.sf3）を開きます。 

 ・Save - 今開いている sf3ファイルを保存します 

 ・Print – 現在開いている view 画面を印刷します。 

 ・Print Preview – 印刷の preview を表示します。 

 ・Copy – 選択時に開いている view のデータをそのままクリップボードにコピーします。タ

ブ区切りのデータとなります。 

 ・Find – 検索用のダイアログを開き viewから該当項目を探します。 

 ・Excel - 現在の View画面情報について、CSVフォーマットで出力。Export- current view 

と同じ。 

 
・BioSample Summarization level – データを BioSample単位にまとめた表示に切り

替えます。 

 ・MS/MS Sample Summarization level – データを Experiment (MS/MS Sample)

単位にまとめた表示に切り替えます。 

 ・Add BioSample – BioSampleを追加。「Load Data」view→「Add BioSample」と同じ操

作（ダイアログ出現） 

 

・Queue Files For Loading – Experimentを追加。「Load Data」view→「Queue Files 

For Loading」と同じ操作（ダイアログ出現） 

 

・Load and Analyze Queue - 「Load Data」Viewにて Experiment と BioSampleの紐

づけが完了しているものの、Experiment の取り込みが未完了な状態の場合、取り込みを開

始します 

 ・Quantitative Analysis – 定量解析（検定）を行います。詳細は「」 

 ・Scaffold Q+/Q+S – Q+/Q+S モジュールを起動します。 

 ・Help – Online help を起動します。 

 

 



77 
 

5. Load Data View 

 

5-1. 概要  

 

 Scaffold では各種機能を持つ View があり、画面左側にそれらの View を切り替えるためのスイッチが 

あります。5章では「Load Data」Viewについて説明しています。 

 「Load Data」View では現在取り込んでいるデータの BioSampleに関してMS Sampleデータを追加/

削除 したり、BioSample自体を追加/削除 する事ができます。 

 

 

 

 

以降 Load Data View 画面について、上図で示す４つのパーツ、 

- Experiment pane 

- BioSample tabs と、Load and Analyze Queue button 

- Information pane 

 

 

に分けて説明していきます。 

 

 

Experiment pane 

BioSample tab 

Load and Analyse 

Queue button 

Information 

pane 



78 
 

5-2. Experiment pane  

 

View 画面上部、「Experiment pane」（下図）では Scaffold で取り込んでいるデータに関する概要を  

確認する事ができるほか、BioSample*やMS Sampleの追加を行う事ができます。 

 

* BioSample … (MS) sampleデータをまとめた、1つ上の階層単位。詳細は「2-1. 概要、結果ファイル

の階層構造」をご確認ください。 

 

 

 

Experiment pane 左側は Experiment の名称 (sf3 ファイルの名称)や取り込んだスペクトルの総数、 

タンパク質のグループ化の設定が表示されています。 

 

右側には３つのボタンがあります。 

 

・Queue Files For Loading 

   現在選択されている BioSample に、新たに MS Sample を加えます。加える MS Sample が       

1ファイルの時に使用します。 

 

・Queue Structured Directories 

現在選択されている BioSample に、新たに MS Sample を加えます。加える MS Sample が      

フォルダ構造になっている時に使用します。 

 

・Add BioSample 

 BioSampleを追加する時に利用します。 

 

 

以下内容の関連項目として、2章の「MASCOT結果取り込み」も併せてご参照ください。 

- MS Sample, BioSample, Category (2-1. 概要、結果ファイルの階層構造) 

- データの取り込み操作 (2-2, 2-3,2-4) 
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5-3. BioSample tabと Load and Analyze Queue button 

 

Load Data View の主体部分では、BioSample 別にタブで構成された画面が表示されています（下図）。 

タブにはBioSample名が、そのすぐ下にはスペクトル数と（BioSampleより上位に位置する）Category名

が表示されています。その下の行には以下２つのオプションの現状について表示されています。 

- データのまとめ方（標準かMUDPIT設定か） 

- スペクトルデータの扱い (condense設定) 

 

 

その下に続いている左右二つの表ですが、画面の右側の表「Files Currently Loaded」が現在 BioSample

に取り込み済みの MS Sample を表しています。一方左側の表「Files in Loading Queue」は、追加は   

されていないが追加されるように設定されているMS Sampleを表しています。左側に項目がある状態で、

真ん中のボタン「Load and Analyze Queue」を押すと、データの取り込みを開始します。 

 

左右どちらの表に含まれるMS Sampleも、右クリック→Remove とすることで取り除く事ができます。

特に右側の「Files Currently Loaded」のデータを取り除くと、各種再計算が自動的に実行されます。 

BioSampleのタブ 

BioSampleに 

取り込み予定の結果 

BioSampleに 

取り込み済の結果 
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5-4. Information pane  

 

Load Data Viewの下部にある表示が「Information pane」です。 

左から順に「Analysis Information」「Fixed Modifications」「Variable Modifications」の  sub 

paneから構成されています。 

 

 

 

 

Analysis Information では、検索に関する条件が表示されています。 

Fixed Modifications 並びに Variable Modifications では、検索時に指定した修飾に関する情報が

記されています。 

 

各種表示は、BioSample tab内の Files Currently Loaded でMS Sampleが指定されている場合、

選択Sampleでの情報が表示されます。何も選択されていない場合はすべての sampleについて該当項目

が列挙される形で表示されます（ただし通常は検索条件がすべて同じデータを取り込むケースがほとんで

あると考えます）。 

 

 

検索条件 修飾 (fixed) 修飾 (variable) 
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6. Protein View 

 

6-1. 概要  

 

 Scaffold では各種機能を持つ View があり、画面左側にそれらの View を切り替えるためのスイッチが 

あります。 

 6章では「Proteins」Viewについて説明いたします。 

各タンパク質に関する詳細な情報、例えばタンパク質全長に対してアサインされた同定ペプチドの分布 

状況であったり、マッチしたペプチドの MS/MS マススペクトルとのマッチング状況を確認したりといった

事は、「Proteins」Viewで行います。 

 

Proteins Viewは、主に３つのパーツで構成されています。 

左上の「Proteins Pane」では同定タンパク質に関する様々な情報を表示しています。 

右上の「Peptides Pane」では、同定タンパク質にアサインされているペプチドに関する様々な情報を表

示して、Proteins Paneの選択項目と連動しています。 

画面下部の「Spectrum Pane」では、Proteins/Peptides pane で選択している内容に関連する    

各種図/グラフ が表示されます。以降各 paneについてより詳しく説明しています。 

 

 

 

 

 

 

Proteins Pane Peptides Pane 

Spectrum Pane 
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6-2. Proteins pane : タンパク質に関する情報を表示  

 

Proteins View の左上、Proteins pane では、同定タンパク質に関する情報が表示されます。画面上部

に左右２つのプルダウンメニューがあります。 

左はタンパク質一覧、右は BioSample/MS Sample 一覧です（下図）。 

 

 

 

右の一覧がBioSampleか MS Sampleかは、選択している表示モードによります。すべての項目につい

て選択・表示するか、個別のタンパク質、個別の BioSample/MS Sampleに対して表示を行うかを選択す

る事ができます。 

 

 

 

 

 

 

 

 

 

プルダウンの下には同定タンパク質に関する各種情報が表としてまとめられています。 

表の各項目についてはそれぞれ以下の通りです。 

 

・Sequence Coverage   

  タンパク質の全長に対して、マッチしたペプチドの箇所を一瞥して確認できる表示です。枠内域がタンパ

ク質全長を、黄色の領域がマッチしたペプチドの箇所を、緑の領域が修飾部位を表しています。タンパク

質が各 BioSample / MS Sample でどのようにマッチしているかを比較する際に利用します。 

・Protein  

  タンパク質の description (短めの機能説明文) 

・Accession  

  タンパク質の Accession number  

・Category  

  属している Category 名 

・BioSample  

  属している BioSample名 

タンパク質一覧 

タンパク質一覧 

BioSample / MS Sample 一覧 

BioSample / MS Sample 一覧 
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・MS/MS Sample  

データの MS sample名 

・m.w.  

  タンパク質の質量 

・Prob.  

  protein probabilityの数値。prefiltered mode で取り込んだ場合は表示されません。 

・%Spec.  

  Sample View の Display optionにもある、「Percentage of all Spectra」 

・#Pep.  

  Sample View の Display optionにもある、「Exclusive unique peptide count」 

・#Unique  

  Sample View の Display optionにもある、「Exclusive unique spectrum count」 

・#Spec  

 タンパク質のグループ化（クラスタリング）設定をしている場合、Display option の「Total spectrum 

Count」を表します。グループ化設定をしていない場合、Display option の「Exclusive Spectrum 

Count」を表します。列の項目名にカーソルを合わせるとどちらが表示されているか、確認する事ができま

す。 

・%Cov.  

 Sequence Coverage (の%) 

 

 

6-3. Peptide pane : ペプチドに関する情報を表示  

 

Protein View の右上、Peptides paneでは、左上で選択された protein にアサインされたスペクトルデー

タに関する情報が表示されています（下図）。 

 

 

 

 

選択中のタンパク質について・・・ 

ペプチドの情報を表示 
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表の各項目は以下の通りです。 

 

 

 

 

 

 

 

 

 

 

・Valid 

チェックが入っているデータは protein probability の計算に使用されます。取り込み時のデフォルトでは 

peptide probabilityの thresholdを満たすすべてのデータにチェックが入っています。 

・Weight/Assigned 

 単純なグループ化が適用されている場合は該当ペプチドがユニークだと緑のチェック、共有ペプチドだと

赤の十字で表示されます。Clustering （類似タンパク質のグループ化）が適用されている時には該当デー

タの weightの数値を表します。ユニークなら 1,シェアならシェア状況に応じて数値が小さくなります。 

・Sequence 

 ペプチド配列を表します。前と後ろの（）に囲われた部分はペプチド直前あるいは直後のアミノ酸を表しま

す。 

・Prob. 

 peptide probability. Prefiltered mode で取り込まれた場合は表示されません。 

・Search engine scores 

 検索エンジンごとに表示内容が異なります。 

- SEQUEST : Xcorr と DeltaCn 

- Mascot : Ion score、Identity score、Delta Ion Score 

- X! Tandem : Expect値(log) 

・NTT 

  missed cleavageあるいは Number of Tryptic Termini (同じ意味ですが検索エンジンなどで用語が異

なります)。 

・Modifications 

  修飾情報 
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・Observed 

   スペクトルデータ側のペプチドの m/z 

・Actual Mass 

  ペプチドの質量 

・Charge 

 ペプチドの電荷 

・Delta Da 

 ペプチド質量の差の Da、実測値 – 理論値  

・Delta ppm 

  ペプチド質量の差の Da、(実測値 – 理論値) / (実測値)  

・Retention Time 

  LCの保持時間 (秒)。データによっては表示されない 

・Intensity 

  ペプチドの Precursorスペクトルでの intensity (面積)。データによっては表示されない。 

・TIC 

  MS/MS 各ピークの intensityの和。 

・Start 

 ペプチド先頭部の、タンパク質全長における位置 (残基番号)。 

・Stop 

 ペプチド末端部の、タンパク質全長における位置  (残基番号)。 

・# Other Proteins 

 シェアペプチドの場合、シェアされているタンパク質の数。 

・Other Proteins 

 シェアされているタンパク質の Accession。 

・Spectrum ID 

  スペクトルの名称。 
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6-4. Spectrum pane :タンパク質/スペクトル 関連図  

 

Spectrum pane (英文マニュアルでは Protein Sequence pane)では、proteins pane や peptides 

pane で選択しているタンパク質やスペクトルに関連する図を表示させることができます。以下５つのタブ

から構成されています。 

 

- Protein Sequence tab 

- Similar Proteins tab 

- Spectrum tab 

- Spectrum/Model Error tab 

- Fragmentation Table tab 

 

以下、各タブの画面について説明しています。 

 

 

6-4-1. Protein Sequence tab 

 

 

Protein Sequence tab では、選択しているタンパク質の全長に対して、アサインされたペプチドが   

どこに位置するのかを表しています。黄色い部分はペプチドがマッチしている箇所、緑のアミノ酸は修飾を

受けていることを表します。また配列の上部にはタンパク質の Accession や Description、質量、アサイン

されたペプチド/スペクトル 数、coverage (%)なども表示されます。 

またタブ内で右クリックを選択する事で、画像として保存したり関連情報をクリップボードにコピーしたり 

する事もできます。 

 

 

 

 

[次頁に続きます] 
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6-4-2. Similar Proteins tab 

 

 Similar Proteins tab では、選択しているタンパク質と同様のペプチドマッチをしているタンパク質  

（グループ）について、その類似度を確認する事ができます（下図）。グループ内のタンパク質すべてに   

ついて、左上の Proteins pane と基本的に同じ情報が表示されます。グループ内のタンパク質において、

ペプチドの重なり度合などを確認する事ができます。 

 

 

 

6-4-3. Spectrum tab 

 

Spectrum tab では、画面右上の Peptides pane で選択中のスペクトルデータについて、スペクトル  

ベースで理論値とのマッチング状況を確認する事ができます（下図）。 

 

 

スペクトルのグラフはインタラクティブに操作/表示 できます。ドラッグ＆ドロップで特定領域を拡大  

したり、拡大後にシングルクリックする事で元の表示に戻したりする事ができます。またタブ内で右クリック

を選択する事で、画像として保存したりピークリスト情報をクリップボードにコピーしたり、配列を BLAST

検索したりする事もできます。 

 

 

 

 

[次頁に続きます] 
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6-4-4. Spectrum/Model error tab 

 

Spectrum/Model Error tab では、右上の Peptides pane で選択しているスペクトルデータについて、 

理論値と実測値との誤差を確認する事ができます（下図）。縦軸が誤差、横軸はフラグメントの質量（Da）で

す。 

 

またタブ内で右クリックを選択する事で、画像として保存したりピークリスト情報をクリップボードにコピ

ーしたり、配列を BLAST検索したりする事もできます。 

 

 

6-4-5. Fragment table tab 

 

Fragment table tab では、右上の Peptides pane で選択しているスペクトルデータについて、理論値  

ベースで理論値とのマッチング状況を確認する事ができます（下図）。色が塗られているところがマッチした

箇所です。「＋2H」は 2 価、「-NH3」「-H2O」は脱アミノ/脱水を表します。またタブ内で右クリックを選択  

する事で、画像として保存したりデータをクリップボードにコピーしたり、CSV ファイルに出力する事が 

できます。 
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7. Grouping,Clustering と Similarity View 

 

Scaffold では各種機能を持つ View があり、画面左側にそれらの View を切り替えるためのスイッチが 

あります。7章では「Similarity」Viewについて説明しています。また Similarityと関連がある内容として、

Scaffoldにて Group化、Clustering化する際のルールについても併せて説明しています。 

 

7-1. Scaffoldでの類似タンパク質の扱い  

 

質量分析データベースのプロテオミクスの解析ではスペクトルデータを元にペプチド配列を同定します。

そしてそのペプチドがどのタンパク質に含まれる配列と同じかという情報を元に同定タンパク質をリストア

ップします。検索対象のデータベース中に、同定ペプチドをシェアするタンパク質が複数存在する事は頻繁

に起こります。 

 ヒットしたペプチドの組み合わせが全く同じ、mascot で「same-set」と呼んでいる組み合わせを、

Scaffold では「protein group」と呼んでいます。Samples リストの中で Accession の表示の後ろに（）

がありその中に＋数字、と表示されているものがこれに該当します（下図）。 

 

same-set より下位、ヒットしたペプチドにオリジナルのペプチドがなく、他により多くのペプチドがマッチ

しているタンパク質が存在するケースを MASCOT では「sub-set」と呼んでいます。Scaffold では 

sub-set のデータは Samples View の同定タンパク質リストに現れず、後述するように Similarity View 

の「No group」に一緒くたにされてしまいます。 

一方シェアするペプチドを持ちながら、他のタンパク質にはアサインされていないユニークなペプチドを

もつタンパク質もあります。MASCOT ではこれらタンパク質はすべて「Family Protein」としてまとめら

れます。取り込み時のグループ化アルゴリズムの選択にもよりますが、Scaffold ではユニークペプチドのみ

ならずシェアペプチドの確からしさに基づいて、クラスター(Cluster)としてまとめられるケースと、リスト中

の他のタンパク質にシェアペプチドが存在する事を示すにとどまるケースがあります。 

以降 7章では、グループ化や Clustering の手法について説明しています。 

 

 

7-2. 表示内容の詳細 : summary画面 

 

Scaffold 4 以降では「Share peptide Grouping」というグループ化・クラスター化のアルゴリズムを適用

する事ができます。Scaffold 3 以前で扱われていた内容については「Legacy Protein Grouping」と呼ん

でいます。 

「Share peptide Grouping」の方法は、従来の方法で求められていた、「高い同定確率であるペプチドが
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『ユニーク』に存在する」という条件適用にこだわると同定タンパク質リストから抜け落ちてしまうような  

タンパク質を救済する事を第一の目的としたアルゴリズムです。 

データ取り込み時に「Protein Grouping」というオプションで「Use protein cluster analysis」という選択

肢を選ぶことでこのアルゴリズムが適用可能です（下図）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

他の選択肢を選んだ場合でも、データを取り込

んだ後に変更することができます。 

メニューの Experiment -> Edit Experiment に

て現れるダイアログにて、ラジオボタン上の 選択

肢にて「use protein cluster analysis」の項目を

選び、「Apply」ボタンを押す事で変更可能です（右

図）。 

 

以降、このグループ化並びにクラスター化の  アルゴリズムの説明のため、内容をさらに以下３つのパート

にわけて説明します。 
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・7-2-1. Protein Grouping (same-set) 

・7-2-2. Protein Paring (sub-set) 

・7-2-3. Protein Clustering (Family protein) 

 

7-2-1. Protein Grouping (same-set) 

 

ヒットしたペプチドの組み合わせが全く同じ、mascot で「same-set」と呼んでいる組み合わせを、

Scaffold では「protein group」と呼んでいます。前述のように、group に複数のタンパク質を含む場合、

Samples view にて Accessionの後ろに（）と＋数字、と表示されます（下図）。 

 

 

 

 

 

 

 

Accession Number のところをクリックすると、group に含まれるタンパク質が表示され、その中から選

択する事でリストに表示されるAccessionを変更することができます（下左図）。またSamples View 下部

の「Protein Information pane」でもグループに属するタンパク質を確認する事ができます（下右図） 

 

 

 

 

 

 

 

グループに属するタンパク質と、そのタンパク質に帰属するペプチドについて着目すると、ペプチドは以下

の 2種類に大別する事ができます。 

- シェアペプチド  … 複数タンパク質にアサインされるペプチド 

- ユニークなペプチド … 単一のタンパク質にアサインされているペプチド 

 

シェアペプチドについてはタンパク質によって配分比率が計算され、確率の計算などにはその配分  比率

が適用されます。配分比率自体はタンパク質の存在が確からしいほど高くなるような計算式になっていて、

主にユニークなペプチドを使って計算します。 
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タンパク質 A における ペプチド p の配分比率 Weight W (p,A) は、以下の式から算出します。 

 

 

 

 

 

 

 

 

分子(numerator)であるPEexcl(A) とは、AにアサインされているすべてのユニークペプチドXの同定確率

Pxを足し合わせたものです（下式）。 

 

 

 

 

 

 

分母(denominator)が意味するところは標準化です。PEexcl(A)と同様ユニークペプチドのprobability和

を、ペプチド pがアサインされているすべてのタンパク質でさらに足し合わせ、その数字で割ると   いう標

準化を行っています。すなわち、他のタンパク質に比べユニークペプチドの数が多く          その

probabilityが高いと配分比率も高くなるようになっています。 

計算された配分比率は Similarity Viewの画面内で表示されます（下図）。 

 

 

 

 

 

 

 

 

 

 

 

 

7-2-2.Protein Pairing(sub-set) 

 

same-setのデータは groupとしてまとめらますが、ペプチドのアサイン状況が sub-set,包含関係的に下

位に位置する状況、の場合、group にはまとめられず Similarity View でのみ確認する事ができます。

Similarity View の画面右側、「No Group」にまとめられています（次頁図）。 
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7-2-3.Protein Clustering (Family Proteins) 

 

MASCOT では、同定基準を超えるシェアペプチドが１つでも存在すれば Family Protein としてまとめ

られます（下記条件 1）。一方 Scaffold の Protein Clustering のアルゴリズムではそれよりも厳しい条件

（下記条件 2）があり、シェアペプチドが一定の基準を超えていなければなりません。 

 

クラスター化のルールは以下の通りです 

＊ 英文マニュアルと記述の構成が少し異なりますのでご注意ください 

 

1. シェアペプチドの probability 値の和が 95% 以上である 

2. シェアペプチドの probability 値の和が、シェア並びにユニークペプチドの probability 値の和に対して 

50% 以上である。 

3. 1,2の条件をすべて満たすタンパク質同士で Familyが構成される 

 

なお、Cluster 形成を検討する段階では Samples Filterの各種条件は検討されません。Cluster形成後、

filter が適用され、Samples 画面に表示されるかどうかが決まります。下記資料に、計算例も含めた説明

がございます。 

https://proteomesoftware.zendesk.com/hc/en-us/articles/115001221723-Protein-Grouping

-and-Clustering-in-Scaffold 

 

Cluster は、Samples 画面にて Row number の横に十字アイコンが表示され、名称も「Cluster of ～」

と表示されています（下図）。Accession の後ろには、Cluster に属するタンパク質の数も[N]の形で表示  

されています。 

 

https://proteomesoftware.zendesk.com/hc/en-us/articles/115001221723-Protein-Grouping-and-Clustering-in-Scaffold
https://proteomesoftware.zendesk.com/hc/en-us/articles/115001221723-Protein-Grouping-and-Clustering-in-Scaffold
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Cluster の Accession number のところをクリックすると、Cluster で表示する代表タンパク質の

Accession に関して選択する事ができます。 

十字ボタンをクリックするとその下に展開し、Cluster に属するタンパク質が一覧で表示されます（下

図）。 

 

 

メニューの View -> Show Entire Protein Clusters を選択すると、Samples画面の各種 Filtering条件

を満たさないタンパク質がグレーアウトの形で表示されます（下図）。ここからも、Family の形成には

Samples の Filtering 条件は関係ないことがわかります。 

 

 

Samples View などで表示される数字について、Cluster では個々のタンパク質とは内容が異なります。 

例えば下図をご覧ください。丸と A,B,C がタンパク質、丸の中の小さい四角の表示がスペクトルを表し、  

タンパク質 Bと Cがクラスターを構成しているとします。Bの Total Spectraは 4、Cも 4ですが Bと C

のクラスターでは和の 8 ではなく 6 であることに注意してください。シェアされているペプチドはまとめて   

１つとカウントされます。 
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7-3. Legacy Protein grouping  

 

ここでは Scaffold 3 以前で利用されていた グループ化のルール（現バージョンでも Legacy Protein 

groupingと呼ばれているルール）について説明しています。 

Legacy Protein grouping ルールが適用されている場合でも、Similarity Viewの表示はほとんど変わり

ませんが、各セルの数値が Weightでなく 同定確率 probability である点が異なります（下図）。 

 

 

 

Legacy protein grouping における、ペプチドのタンパク質への帰属方法は以下の通りです。 

大まかにいうと、ペプチド帰属はタンパク質の同定の確からしさの大きい方にペプチドを帰属させる、と 

いうルールとなっています。 

 

そこでまずタンパク質毎に、アサインされたペプチドの probabilityの和を算出します（下図）。 
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ペプチド単位でデータを眺めた際、シェアされているタンパク質の中で最も probability の和が大きい 

タンパク質に帰属させます。値が同じタンパク質が 2つ以上ある場合はそのすべてに帰属させます。下図で

は緑に塗られた箇所が帰属する位置です。 

 

 

続いて、緑に塗られたペプチドがないタンパク質をリストから除きます（下図）。 

 

 

 

 

 

 

 

 

 

 

 

 

最後に、緑に塗られたペプチドの中でprobabilityが95%未満のものしかないタンパク質をリストから除き

ます（下図）。 

 

 

 

 

 

 

 

 

 

 

 

最終的に残ったものが Legacy proteins groupでまとめられる「group」となります。 
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7-4. Samples View と Similarity Viewとの関連について  

 

類似(Group,Cluster)タンパク質の類似状況と、Samples View 並びに Similarity View でそれらが

どのように表示されるかについて、改めて説明します。 

 

 

 group [same-set] のタンパク質は、Samples view で代表タンパク質１つにまとめられて表示され  

ます（下図）。Accession Number の後ろに（＋数字）の形で表示され、カーソルを合わせると画面下部の 

Protein Information pane に groupに属する他のタンパク質の情報を確認する事ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

MASCOTでいう sub-set のタンパク質は、samples view には全く表示されません。Similarity View 

の「No group」欄にまとめて表示されます（下図）。 
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Family protein に属するような、シェアペプチドを持ちつつユニークなペプチドを持つ場合で、シェア 

ペプチドの確からしさもある程度保証されている場合、Samples View には「Cluster」としてまとめられ

て表示されます（下図）。 

 

 

一方 シェアペプチドの確度が基準を満たさない場合や、古いバージョンの Grouping アルゴリズムを  

使った場合、Samples View において特にタンパク質をまとめた表示は行いませんが、Similarity View 

にてその重複度合いをチェックする事ができます。 

Cluster も含め、シェアペプチドをもつタンパク質は  Samples View にて「Protein Grouping 

Ambiguity」列の星印がついています（下図）。 

 

 

星印をダブルクリックすると 該当タンパク質に関する Similarity view に切り替わります（下図）。 
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Similarity view で内容をチェックしたことのあるタンパク質は Samples View で星の色が緑に    

代わります（下図）。切り替わる前の星の色は赤色です。 

 

 

7-5. Similarity View概要  

 

 「Similarity」View では、特定タンパク質とマッチング内容が類似する別タンパク質について、ペプチド

の重なり具合などをチェックすることができます（下図）。 

 

 

 

 

Protein 

Pulldown list 

Similarity table 

Identification pane 
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「Similarity」View画面は主に３つのパーツに分かれています。 

 

画面上部にある「Protein Pulldown list」は、現在選択中のタンパク質を表します。 

 

「Similarity table」 は類似タンパク質とのペプチドの重複度合いを確認する事ができます。 

 

「Identification pane」では、「Similarity table」にて選択しているペプチドに関して関連情報を表示  

する欄で、「Proteins View」画面の右上「peptides pane」や、下部「Spectrum pane」と同じ内容です。  

項目の詳細については、Protein View 内画面の各説明「6-3 peptide pane」「6-4.Spectrum pane」を 

ご参照ください。 

 

本資料では、メインとなる表示「Similarity table」についてのみ説明しています。 

 

Similarity view の画面上段から中段にかけて表示されている画面が「Similarity table」です（下図）。

類似タンパク質について、どのペプチドがシェアされているのかを確認する際に利用します。 

 

 

各列の項目はそれぞれ以下の通りです。 

 

・Index - ペプチドの通し番号 

・Peptide – ペプチド配列 

・Prob. - ペプチドの同定確率。prefiltered mode で取り込んだ場合、すべて「99%」と表示 

・Exclusive to - ユニークペプチドかどうか。ユニークな場合、タンパク質名が表示 

・Valid – ペプチドを解析に利用しているかどうか。ユーザーが自らクリックし、使用するかどうかを経能 

する事もできます。 

 

その次の列からはタンパク質になります。タンパク質はユニークなタンパク質毎に、あるいはクラスター 

ごとに色分けで表示されています。”Exclusive to” 列にタンパク質名の表示と着色があり、最上列の    

タンパク質の色と連動しています。 

ペプチドとタンパク質が交わる各セルに表示される数字は、新しいグルーピングアルゴリズムが採用され

ている時はWeightの数値が表示されます。Legacy protein grouping の時は Probability が表示され
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ます（右下図）。ペプチドがアサインされているタンパク質のセルのみ数字が表示されます。 

 

タンパク質の Accession の下に＊がある

場合、ペプチドの同定基準を満たしユニーク

なペプチドが存在するものの、タンパク質の

同定基準を満たせず現段階の Samples の 

リストには表示されていない タンパク質で

あることを示しています  （ ＊右図の

ALBU_PIG など） 
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8. Quantify View  

 

8-1. Quantify View : 定量指標を基にしたグラフや GO,ベン図を表示  

 

Scaffold では各種機能を持つView（画面）があり、左側にそれらのViewを切り替えるためのスイッチが

あります。定量値に関するグラフを表示したり、同定結果のベン図やGene Ontologyに関する図・グラフを

表示したりする事ができるのが「Quantify」Viewです（下図）。 

Quantify View は大きく分けると４つのパートから構成されています。 

 

 

・Quantitative Value pane （左上） 

 選択中のタンパク質について、サンプル 別の定量に関連する値(Quantitative value)の比較ができる  

棒グラフが表示されます。 

 

・Quantitative Scatterplots pane （右上） 

サンプル間で各タンパク質の定量値に関する散布図や volcano plot が表示されます。 

 

・Venn Diagrams pane （左下） 

同定タンパク質/ペプチドに関してサンプル別に比較ができるベン図が表示されます。またベン図の   

各エリアに属するタンパク質/ペプチド を確認する事ができます。 

 

・Annotation charts pane (右下) 

Samples に表示されているタンパク質のGene Ontologyの項目情報やPathwayの項目情報について

8-2. Quantitative Value pane 8-3. Quantitative Scatterplot pane 

8-4. Venn Diagrams pane 8-5. Annotation charts pane 
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まとめた円グラフなどが表示されます。 

Quantify 内の表示内容は連動しており、例えば Quantitative Value paneのプルダウンでタンパク質

を選択すると Quantitative Scatterplot paneや Venn Diagrams pane で該当タンパク質が強調表示

されます。 

 

以降、各 pane について説明しています。 

 

 

8-2. Quantitative Value pane  

 

画面左上が Quantitative Value paneです。縦軸が Quantitative value で各サンプル別の棒グラフ

が表示されます。縦軸の値は Experiment -> Quantitative Analysis で選択している「Quantitative 

Method」の選択肢に連動しています。選択肢内容については、「11-2.ラベルフリーの定量方法」をご参照

ください。 

 

 

 

 

 

 

 

 

 

 

 

 

グラフ内で右クリックをすると、各種画像ファイルへのエクスポートや印刷、データのテキストコピーなどの

選択肢が現れます。 

 

 

8-3. Quantify Scatterplots pane  

 

画面右上が Quantitative Scatterplots pane です。定量値について、サンプル間で比較して確認   

したい際に利用します。以下の３つのタブから構成されています。 

 

・ 8-3-1. Scatterplot タブ 

・ 8-3-2. Stdev Scatterplot タブ 

・ 8-3-3. Volcano Plot タブ 

 

以降、Quantify Scatterplots pane内の各タブについて説明します。 
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8-3-1.Scatterplotタブ 

 

X軸と Y軸に、チェックしたいサンプルをプルダウンから選択します。それぞれの軸の値はQuantitative 

value を表し、各点はタンパク質に該当します（下図）。Quantitative Value pane と同じく、

Quantitative valueが具体的に何を示しているかは Experiment -> Quantitative Analysis で選択し

ている「Quantitative Method」の選択肢に連動しています（同ダイアログ内の「Use Normalization」や

「Minimum Value」選択とも連動しています）。 

 

 

 

グラフ内の各点について、カーソルを合わせると縦軸と横軸の値、並びに Accession の情報が表示され

ます（上図内①）。またクリックするとタンパク質を選択したことになり（上図内②）、そのタンパク質の情報

について左上の Quantitative Value pane での図表示や、左下の Venn Diagrams でのハイライト表示

と連動します。 

また、図内には y=x の直線が引かれる（上図内③の実線）ほか、±σ、±2σ、±3σに該当す線も引かれ

ます。 

さらに検定を実施している場合、有意基準に達しているかどうかで各点の色が変化します。検定でなく

Coeeficient of Variance (変動係数)が選択されていた場合は 1以上の時、Fold Change が選択されてい

た場合は 2以上、または 0.5 以下の時に「有意」としています。 

 

 

 

 

 

 

 

① 

② ③ 
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8-3-2.Stdev Scatterplotタブ 

 

Stdev Scatterplot タブでは、Coefficient of variance (または variation、変動係数:CV)の評価に利用

するグラフです。Quantitative Value のばらつき具合を見ています。各点はタンパク質を表し、横軸が 

Quantitative Valueの（カテゴリー内）全サンプルにおけるMeanについて Log10とったもの、縦軸が 同

様の数値の SD です（次頁図）。もし検定が行われている場合は検定の対象として選択している sample の

み、表示対象とされます。 

 

 

グラフ内の点線は各プロットから計算された回帰直線です。データのばらつきが大きなタンパク質を  

識別し、定量の検証に使うかどうかを判断する事もできます。 
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8-3-3.Volcano plotタブ 

 

Volcano plot はタンパク質のサンプル間での変動を見るのに便利なグラフです。前提として、対象   

サンプルを選択した上での検定を実施する必要があります。 

 

X軸は Scatter plotタブで選択中の２カテゴリーにおける fold changeの Logです。fold changeとは

この場合単純に比（割り算）の事をさし、その値に対して Log2 をとっています*。 

＊各所で用いられる用語のばらつきによっては、本グラフの横軸である、比の Log2 の事を Fold 

change と呼称する場合もあります。 

 

Y 軸は検定の結果計算された各タンパク質の p-value について Log10 をとりマイナスをかけたもので

す。 

 

従って、X軸については左右の方向にいけばいくほど、Y軸については上に行けば行くほど該当タンパク

質が選択サンプル間で大きく変動していることを意味します（次頁図）。 

 

 

他のグラフ同様、各点はタンパク質を表し、点にカーソルを合わせると accession 並びに X/Y 軸の値が

表示されます。またクリックするとそのタンパク質の情報について左上の Quantitative Value pane での

図表示や、左下の Venn Diagrams でのハイライト表示と連動します。 

 

X 軸の 0 の値、すなわち変動がないラインついてはグラフ表示のオプションで変更することができます。

また同様に Y軸の Significantのラインについても変更可能です。 
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8-4. Venn Diagrams pane  

 

Quantify 画面の左下、「Venn Diagrams pane」では最大３つのカテゴリーを対象にベン図を書かせる

ことができます。「Proteins」「Total Unique Peptides」「Total Unique Spectra」３つのタブから構成され、

それぞれタンパク質/ペプチド/スペクトル数 についてベン図を描く事ができます（下図）。 

 

 

 

ベン図内の各領域を選択しクリックすると黄色のハイライト表示がされ（上図①）、選択領域に属する   

タンパク質/ペプチド/スペクトル の一覧がその右側に表示されます。表内にて青色でハイライト（上図②）

を受けているのは現在選択されているタンパク質で、表内の行をダブルクリックする事でタンパク質を切り

替える事もできます。 

また表内のエリアをダブルクリックすると Samples View に切り替わり、その時に選択エリアに 属する

タンパク質だけがフィルターリングで残された状態となっています。元の状態に戻すには Samples 画面上

部の「Search」のところにある文字列を削除し空欄にします。 

 

グラフの上の「Counting Unit」では、数え上げる対象をクラスター単位とするか個々のタンパク質と  

するか変更することができます。データ取り込み時のグループ化オプションによっては表示されません。 

また「Evaluate based on」は対象とするタンパク質についてのオプションで、「Presence/Absence」は

Samples 表での有無で判断するのに対し、「Quantitative profile」は検定に使用されたかどうかで判断 

されます。従って「Quantitative profile」は検定を行った時にしか選択する事ができません。 

 

8-5. Annotation Charts pane  

 

Quantify View の右下、「Annotation Charts pane」では、各タンパク質にアサインされた Gene 

① 
② 
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Ontology または Pathway 情報に関してまとめた図を表示します。それぞれ、２つのタブ「Pie Charts」

「Bar Charts」から構成されます。 

例えば Gene Ontologyでは「Biological Process」「Cellular Component」「Molecular Function」 

から構成されていますが、画面上部のプルダウンから該当項目を選ぶことで表示内容を切り替える事が 

できます。 

 

「 Pie Charts 」 タブ  では Samples で表示されているすべてのタンパク質について  Gene 

Ontology/Pathway 情報の項目を数え上げ、それを円グラフにて表示しています（下図）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

一方同様の情報を棒グラフにて表示しているのが「Bar Charts」です（下図）。 
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9. Publish View  

 

9-1. Publish View : Method の文章化  

 

Scaffold では各種機能を持つView（画面）があり、左側にそれらのViewを切り替えるためのスイッチが

あります。 

 9 章では「Publish」View について説明しています。各種論文投稿時、データ解析に関する説明文を記載

する必要がありますが、その目的に役立つのが Publish View画面です。 
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画面左側が、解析内容について項目別にまとめられた表です。取り込んだデータの内容に合わせて   

項目が自動入力されます。項目前に鍵マークがついている欄はユーザーによる書き換えができません。 

 

赤い強調表示されている項目はユーザーの手入力による穴埋めが促されています。そのうち入力欄に

「∨」となっている箇所については、クリックする事で選択肢が現れユーザーが選択をする形になっていま

す。 

 左側の表に入力された内容に合わせて、右側の説明文が自動的に編集されます。右側の説明文について

はドラッグ＆ドロップで文章を選択できるほか、ショートカットキーなどでテキストをコピーする事ができま

す。ユーザーはこの文章を出発点とし書き換えたものを 論文投稿などでの method に利用する事ができ

ます *1。 

 

右側下部には情報を EXCEL で読むことができる形式で出力できるボタンがついています。各ボタンに

よって出力される内容は、メニューの「Export」にて選択できる内容と同じです。詳細は「4-1.メニューの 

内容 説明一覧」の「Export」欄をご覧ください。 

 

 

＊1  

Scaffold を利用した解析においては、論文投稿時に以下論文を参照してください。 

https://onlinelibrary.wiley.com/doi/abs/10.1002/pmic.200900437 

https://onlinelibrary.wiley.com/doi/abs/10.1002/pmic.200900437
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10. Statistics View 

10-1.Statistics View 概要 : 同定確率計算に使用したスコア分布などを表示  

  

Scaffold では各種機能を持つ View（画面）があり、左側にそれらの View を切り替えるためのスイッチが

あります。 

 「Statistics」View では、主にペプチド同定やタンパク質同定のアルゴリズムに関連するデータ・グラフを

表示する事ができます。従って、データを Prefiltered mode で取り込んだ場合は何も表示されません。 

 

 

Statistics View は主に４つの画面から構成されています。 

 

左上、MS Sample table は、Experiment内の MS Sampleに関する情報をまとめた表です。 

右上、Statistics View Upper Right paneは、「FDR Browser tab」「Peptide RPC Plots tab」「Protein 

Probability Calculation tab」３つのタブから構成されていて、ペプチドやタンパク質の probability計算

に直結する数値を確認できるグラフです。 

左下、Multiple Search Engine Scatter Plot paneは、複数の検索エンジンでのスコアを比較する散布

図です。 

右下、Peptides Validation pane は、検索エンジンでのスコア分布と適用アルゴリズムでの分布を同時

に確認できるグラフです。 

 

左上の MS Sample tableで選択されている項目について、他の paneのグラフ・図が表示されます。 

選択の変更によってグラフもインタラクティブに表示が切り替わります。また画面上部の各種フィルターの

選択内容にもインタラクティブに対応します。 

 

10-2. MS Sample table 10-3. Statistcs View Upper Right pane 

10-4. Multiple Search 

Engine Scatter Plot pane 

10-5. Peptide Validation  pane 
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10-2. MS Sample table  

Statistics View の左上、MS Sample table は、MS Sample に関する情報がまとめられています （下

図）。表示される情報は以下の通りです。 

 

 

 

 

 

 

 

 

・Category -属する Category 名 

・BioSample -  属する BioSample 名 

・MS/MS sample – MS Sample 名 

・#Prot - 同定タンパク質数 

・#IDs – ユニークな同定スペクトル数。MS/MS Sample View モードでの、Exclusive Spectrum 

Counts の和（下図、黄色の枠で囲まれた箇所を参照）。またクラスターモードの時にも個々のタンパク質に

ついてカウントされます。 

・#Spec （ユニークでないものも含む）同定スペクトル数。 

・%IDs 同定スペクトル中に占めるユニークスペクトルの割合。 #IDs / #Spec。 
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10-3. Statistics View Upper Right Pane  

 

Statistics View の右上の paneには公式に名称を付けておりませんが、主にペプチドやタンパク質の同定

の検証に関連する情報を提供しています。 以下３つのタブから構成されています。 

- 10-3-1. FDR Browser タブ 

- 10-3.2 Peptide ROC Plots タブ 

- 10-3-3. Protein Probability Calculation タブ 

 

以降、１つ１つのタブについて説明しています。 

 

10-3-1. FDR Browser タブ 

 

通常データベースに加え decoy データベースへの検索も実施している時のみ現れるタブです。Peptide 

Probability と Protein Probability の組み合わせにより、基準を超えるタンパク質がいくつになるかをヒ

ートマップで表しています（下図）。赤がタンパク質の数が少なく緑が多くなっていますが、基本的に赤の領

域ほど確度の高いタンパク質の領域です。ヒートマップの描写はグラフ下の設定 数値と連動しています。

設定値には「Max.Protein FDR」「Max Peptide FDR」「Min # Peptides」の３種類があります。 

 

 

 

このグラフの一番の目的は、Peptide Probabilityと Protein Probabilityの組み合わせが同定タンパク

質数にどのように影響を及ぼすのかを確認する事です。解析の目的に応じて Peptide, Protein の

Probabilityの Threshold を変更し状況に合わせた同定タンパク質リストを作成する事ができます。 

表示されているヒートマップ上にカーソルを合わせると、その位置における Peptide Probability, 

Protein Probability、基準を超えるタンパク質数とともに、Peptide や Protein の FDR の値も表示され
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ます（下図、青枠）。また、グラフの中には条件によりプロットが現れる事があります。青い〇は現在の条件

の中で最も拾い上げるタンパク質が多くなり、かつ各基準値の値が高くなる位置を表します。ピンクの〇は

現在 Filter として設定しているアサインペプチド数とグラフ内の Min # Peptides が 同じ時のみ表示さ

れ、filterの設定箇所を表します。 
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10-3-2. Peptide ROC Plots 

 

Peptide ROC Plot タブでは、ROC カーブの図が表示されます。ペプチド同定において、同定基準と、

Sensitivity / Specificityのバランスを確認するために利用します。 

横軸に偽陽性率（1-特異度 ( 陰性を陰性と判断する率]）、縦軸にはここでは 同定ペプチド数をとったグ

ラフです。 * 通常は Sensitivity (陽性を要請と判断する率)とする事が多いです。各判定方法  （ペプチド

同定アルゴリズム）の、各同定基準値において、False Positive Rate と 同定ペプチド数がそれぞれいくつ

なのかを表す線が描かれています（次頁図）。Statistics Viewの左上、MS Sample pane にて選択されて

いる MS Sample についてのグラフが表示されます。 

 

グラフの中の Sensitivityや Specificityの数値については、右下のタブ「Peptide Validation pane」の

表示内容から計算されています。具体的には、Correct を Positive、Incorrect を Negative と認定してそ

れぞれのスコア分布から、各スコアにおける Sensitivityや Specificityが計算されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

本来の ROC カーブは縦軸が Sensitivity で、y=x の直線を引いてその直線と各プロットがどれくらい

離れているかが有効な判定方法かを評価する目安とりますが、本ソフトウェアのグラフでは縦軸の値が異

なるためそのような見方をすることができません。よりグラフの左上方向に曲線が向かっている判定方法

が優秀である、といった見方だけが可能です。 
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10-3-3. Protein Probability Calculation タブ 

 

Protein Probability Calculation タブは、アサインされたペプチド数別に Peptide probability と

Protein Probability の関係性を表したグラフです。検索を行った query 数が少ない場合は表示されませ

ん。Statistics Viewの左上、MS Sample pane にて選択されている MS Sample についてのグラフが

表示されます。 

 Scaffoldで採用されている、タンパク質同定確率を表す「Protein Probability」は、そのタンパク質にアサ

インされているペプチドの「Peptide Probability」から計算されています。計算式には検索のパラメータや

FASTAのデータベースサイズが関係しています。 

 

 

グラフを見ると、1アサインペプチドの場合には peptide probabilityが 95%でも protein probability 

が十分な値ではない（上図例では 70%）である事がわかります。逆に 2つ以上のペプチドがアサインされて

いるタンパク質では、peptide probabilityが十分な値でなくても protein probabilityが高い値になる事

がわかります。 

 

 

 

 

 

[次頁に続きます] 
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10-4. Multiple Search Engine Scatter Plot pane  

 

Statistics View の左下、「Multiple Search Engine Scatter Plot pane」では、同じ queryに対して複数

の検索エンジンを適用した場合の、スコアの違いをプロット化したグラフが表示されます（下図）。

Statistics Viewの左上、MS Sample pane にて選択している MS Sample についてのグラフが表示さ

れます。 

 

二軸それぞれに検索エンジンのス

コアが配置され、それぞれの（同

定）基準値が横軸/縦軸に点線で

表示されます。また各プロットは

correct に 属 す る デ ー タ と 

incorrect に属するデータで色分

けされます。さらに、Scaffold の

peptide 同定確率を判定するプロ

グラム peptide prophet のライ

ンが ”combined 95%” と表記さ

れている実線としてグラフに表示

されています。 

 

 

10-5. Peptides Validation pane  

 

Statistics View 画面の右下、Peptides Validation pane では、各検索エンジンのスコア分布から 

peptide probability 算出に利用するスコア分布をどのように変換しているか確認できるグラフが表示さ

れます。 

評価アルゴリズムとして Peptide Prophet が選択されていた場合、各検索エンジンにおいて、電荷別の

スコア分布が表示されます。横軸

にはマッチング内容を評価するス

コアが、縦軸には個数が 表された

棒グラフが表示されます（下図）。

棒グラフは incorrect と correct 

別に色分けがされており、あるス

コア位置での両社の割合がそのま

ま peptide probability として評

価されます。 
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11. 定量手法と検定 

 

11-1. 概要  

 

 Scaffold では、いくつかのLabel Freeの定量手法 (Spectrum Counting とMS1 イオン強度ベースの

定量)に対応しています。また定量の数値を元にした検定も実施する事ができます。この章では以下の内容

で、Scaffold で対応している定量手法と検定について説明しています。 

 

11-2.  ラベルフリーの定量手法 

11-3. Normalization について 

11-4. 検定 

 

11-2. ラベルフリーの定量方法  

 

Scaffold で対応しているラベルフリーの定量手法は大きく分けると以下の３つの手法に対応しています。 

- Spectral Counting [11-2-1] 

 各タンパク質にアサインされている、同定スペクトル数(または同定ペプチド数)を元にした定量指標

です。 

- Total Ion Count [11-2-2] 

MS2のスペクトルの intensity 情報を定量情報として利用します。 

- Precursor Ion Intensity quantitation [11-2-3] 

(利用できる場合のみ) MS1のペプチドの Intensity 情報を定量情報として利用します。 

 

 Scaffold では、各手法に分類される選択肢がそれぞれ複数存在します。以降で各選択肢について説明  

しています。 
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11-2-1. Spectral Counting  

 

Spectral Counting は各タンパク質にアサインされている、同定スペクトル数(または同定ペプチド数)を元

にした定量指標です。Scaffoldでは以下の 4項目が選択可能です。 

- total Spectra 

- Weighted Spectra 

- emPAI 

- NSAF 

以下、各手法について説明します。 

 

■ total Spectra 

 タンパク質にアサインされた同定スペクトルの数です。Normalization （11-3 をご参照ください）も実施

されています。 

■ Weighted Spectra 

 タンパク質にアサインされた同定スペクトルのうち、他のタンパク質にもアサインされているシェアされた

スペクトルについては、そのシェアされている度合いにより小さな数字としてカウントした数です。詳細は 

英文マニュアルの「7-2-1. Protein Grouping (sameset)」内に記述されている weightの計算式などをご

参照ください。Normalization（11-3をご参照ください）も実施されています。 

■ emPAI 

 タンパク質にアサインされた同定ペプチド数を、タンパク質の大きさで有利/不利 が生じないよう標準化

処理をされた定量指標です。 

emPAI は Exponentially Modified Protein Abundance Index の略です。 

PAI 自体は以下の式のように、タンパク質にアサインされたペプチド数(N_observed)を、そのタンパク質 

から得られる理論ペプチド数（N_observable）で割った数値です。 

 

 

 

 

＊元の論文では保持時間や各種条件によりペプチドを数え上げる際にフィルターリング条件も含んでいま

す。 

 

emPAIは、PAIを使って以下のようにあらわす事ができます。 

 

 

 

Scaffold では、計算の簡易化を目的に論文で適用されているルールとは異なるルールで N_observed や

N_observableをカウントしています。Matrix Science社で使用している以下ルールと基本的に同じです。 

http://www.matrixscience.com/help/quant_empai_help.html 

レアケースにおいて Scaffold でしか採用していない独自ルールがありますが詳細は英文マニュアルを  

ご参照ください 

http://www.matrixscience.com/help/quant_empai_help.html
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■ NSAF 

 NSAF もタンパク質の大きさで有利/不利 が生じないように標準化処理をし、さらに同定スペクトル数 

全数との比を考慮した定量指標です。NSAFは Normalized Spectral Abundance Factor の略です。 

論文で提示されている NSAFの計算方法ですが、まず Number of spectra (論文では SpCと表記)をタ

ンパク質の全長（L）で割った、SpC/L が「SAF」です。解析別に SAF の値をすべて足した値で各 SAF を  

割って標準化（Normalized）したのが NSAF です。 

Scaffold では SpC のところで「number of exclusive spectra」を適用しています。また normalization 

は「11-3. Normalizationについて」で説明する方法が採用されています。 

 

11-2-2. Total Ion Count  

 

Total Ion Count  MS2 のスペクトルの intensity 情報を定量情報として利用します。以下の     

3項目が選択可能です。 

- Average TIC 

- Total TIC 

- Top Three TIC 

以下、各手法について説明します。 

 

■ Average TIC 

query の MS/MS スペクトル内のすべてのピークについて、その強度の平均値を定量情報として利

用します。 

■ Total TIC 

query の MS/MS スペクトル内のすべてのピークについて、その強度の和を定量情報として利用し

ます。 

■ Top Three TIC 

query の MS/MS スペクトル内のすべてのピークの中で強度の強い top3 について、その強度の和

を定量情報として利用します。 

 

11-2-3. Precursor Ion Intensity quantitation  

 

Precursor Ion Intensity quantitationはMS1のペプチドの Intensity 情報を定量情報として利用   し

ます。以下の 4項目が選択可能です。 

- Average Precursor Intensity 

- Total Precursor Intensity 

- Total Three Precursor Intensity 

- iBAQ 

この定量手法を利用するためには、Scaffold の取り込み前に別のソフトウェアで手法に合わせた    解

析を実施する必要がある他、その時の解析ファイルを別途取り込ませる必要があります。詳細は    以下

の資料あるいは英文マニュアルの 14章をご参照ください。 

http://www.proteomesoftware.com/pdf/loading_search_engine_results_into_scaffold.pdf 

http://www.proteomesoftware.com/pdf/loading_search_engine_results_into_scaffold.pdf
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以降、各手法について説明します。 

 

■ Average Precursor Intensity 

   タンパク質にアサインされているペプチドの定量値について、幾何平均を定量情報として利用   しま

す。 

■ Total Precursor Intensity 

  タンパク質にアサインされているペプチドの定量値について、すべての和を定量情報として利用  しま

す。 

■ Total Three Precursor Intensity 

  タンパク質にアサインされているペプチドの定量値について、上位３つの和を定量情報として利用しま

す。データ数が 3つ以下の場合、すべての和を利用します。 

■ iBAQ 

 MS1 intensity ベースの定量に、emPAI の概念を組み合わせたような計算です。ペプチドの定量値の和

を、該当タンパク質の理論ペプチド数で割ります。 

 

11-3. Normalizationについて  

 

Scaffold の定量計算では、サンプル間の誤差を吸収するための標準化処理が行われます。その前提と

なる考えが、「各サンプル (MS Sample) で同定されるタンパク質の全量は変わらない」というものです。

Spectrum Counting なら同定スペクトル数の和が、MS1 や MS2 の Intensity ならその総和の  値が

全サンプルで同じであるという前提の元、平均より多い（大きい）場合は少なく（小さく）なる   ように、

少ない（小さい）場合は多く（大きく）なるように調整されます。従って、サンプル間の     タンパク質全

量が等しくないと思われるケースではScaffold のNormalizationを適用しない方が良いことになります。 

同様に、ダイナミックレンジの中で全量が少ないタンパク質は Normalization の影響を大きく受けて差

が出やすくなり、本来の値からずれる事も大きくなる点に注意してください。（Scaffold の場合、intensity

の値が小さいタンパク質やアサインされたスペクトル数が少ないタンパク質の事をさします。） 

 

Normalization を実行す

る /しない、については、

menu の Experiment -> 

Quantitative analysis で

開くダイ アログの右下 、

「 Other Setting 」 の中に

「Use Normalization」とい

う項目があります（右図）。 
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なお、欠損値(Missing values)については、予め定めた最小値 (Minimum value)に置き換えて標準化

計算の処理をします。Minimum value はデフォルトで 0に設定されています。また設定した 最小値より

小さな値も最小値に置き換えられてから計算されます。 

 

11-4. 検定  

 

Scaffoldでは算出された定量値について各種検定を実施できます。検定の計算時に利用される数値は、

ペプチド・タンパク質などの各種フィルターリング条件を満たすものだけが対象となります。 

 

検定とは別に、Fold Change (比)の値を表示させることができます。 

 

利用可能な検定は選択しているカテゴリー数やカテゴリー内のデータ数などで変更され、合わない手法

についてはグレイアウトされる事があります。 

 

・Coefficient of Variance or Coefficient of Variation 

・T-test 

・ANOVA 

・Fisher’s Exact Test 
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検定を実施すると、Scaffold上でいくつかの変化があります。 

■Samples View : 検定の結果、有意性を示す数値(p-value など)と、変動の様子を表す列が表示される

ようになります。 

■Quantify View :Quantitative Value pane にて、検定の有意性と関連した値がグラフに表示されるよ

うになります。 

 

Fold Change 並びに各検定項目について、以降で説明いたします。 

 

 

■ Coefficient of Variance or Coefficient of Variation  

CV、変動係数は標準偏差を平均で割ったもので、データのばらつき度合を表します。値が大きい  ほど

ばらつきが大きい事を意味します。Scaffold では %表示となっています。値が大きな場合、   サンプル

のうち最低 1 つの値が大きくずれていることを表し、値を（グラフなどで）見比べる事で変動のあったサン

プルを特定していく事ができます。 

■ T-Test  

T検定では2つのカテゴリー間の平均に有意差があるかを検証しています。Scaffold では両側検定を行

っています。T検定を実施すると、p-value がSamples画面にレポートされます。T検定を実施   するに

はカテゴリーが 2つ以上選択されている必要があります。 

■ ANOVA  

 ANOVA (ANalysis Of VAriance、分散分析)では、3つ以上のカテゴリー間の平均に有意差があるかを検

証しています。ANOVA は様々な手法がありますが、Scaffold で採用されているのはシンプルな手法のみ

です。ANOVAを実施すると p-valueがSamples画面にレポートされます。p-valueが小さい  場合、CV

による評価同様少なくともカテゴリーの中のどれか１つが他と異なる事を示しますが、   具体的な内容

はわかりません。値をグラフなどで見比べる事により変動のあったサンプルを特定して いくことができま

す。 

■ Fisher’s Exact Test  

 Fishers Exact Test (フィッシャーの正確確率検定、フィッシャーの直接確率検定)は、T検定同様   2サ

ンプル間の比較により両サンプル間に差異があるかを判定する手法です。T 検定との選択における大まか

な目安として、カテゴリー内の繰り返しが少ない場合（2回など）にF検定を適用する事を   お勧めします。

フィッシャーの正確確率検定を実施すると p valueが Samples画面にレポートされ、その小ささで差異が

あるかを判断します。 

p-valueの算出に関しては、以下論文で議論され構築されたモデルに基づいています。 

 

[論文] 

Zhang, B., VerBerkmoes, N.C., Langston, M. A., Uberbacher, E., Hettich, R. L., Samatova, N. F. 

Detecting differential and correlated protein expression in label-free shotgun proteomics 

J. Proteome Res., 2006, 5 (11), pp 2909–2918. DOI: 10.1021/pr0600273 
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■ Multiple Test Correctionと Significance Level  

検定の選択画面の下に、多重検定補正の実施に関する選択肢と、実施する場合の閾値を設定する画面が

あります。 

 

 

 

 

 

多重検定の際に擬陽性が増加してしまう事を考慮し、別途評価基準を設けて当初の目的に合わせた新た

な基準の線引きをする、というのがこの手法の目的です。Scaffoldでは以下の手法が準備されています。 

- Benjamini-Hochberg 

- Borferroni 

- Holm Step-down 

- Hochberg Step-up 

Significance Level は、多重検定補正においてはよく「ファミリーワイズエラー率（FWERと表記される事

が多い）」と呼ばれます。それぞれの手法について、以下簡単に補足説明を加えます（説明の都合により項

目の順番を変更して説明しています）。 

 

◇ Borferroni 

 この手の手法で最も単純で初期の頃に提唱された手法です。設定したい p-value に対し、検定の数で割

り算をします。しかしこの数値の場合基準が厳しくなりすぎる（有意基準に満たないものが多くなってしま

う）という事で、現在ではこの手法は選択されず別の手法が使われる事が多くなっています。 

 

◇ Hochberg のステップアップと Holmのステップダウン 

Bonferroni の不等式をベースとしていますが、様々な点を考慮し基準が厳しくなりすぎないような補正

が追加されています。同定タンパク質数が少ない場合はこの手法が向いています。 

詳細は英文マニュアル Appendix E の「Holm’s and Hochberg’s Techniques 

to Control the Familywise Error Rate」をご覧ください。 

 

◇ Benjamini-Hochberg 

タンパク質の数が少なすぎない場合は基本的にこちらを選択してご利用ください。Hochbergのステ

ップアップやHolmのステップダウン同様、厳しすぎない程度に補正されます。Scaffoldに  おける計

算では以下の論文で提唱されたモデルを利用しています。 
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[論文] 

Benjamini Y. and Hochberg Y. Controlling the False Discovery Rate: A Practical and 

Powerful,Approach to Multiple Testing Journal of the Royal Statistical Society, Series B 

(Methodological),1995, Vol.57, No. 1: 289-300 

 

■ Fold Change  

複数のサンプル間での比較を行うための検定をご紹介してきましたが、もっと単純な、何かの値を ベー

ス(Reference)に比をとって表示する「Fold Change」を表示させることもできます。 

Biosample が２つしかない場合のみ「Fold Change by Sample」が選択できます。また、Quantitative 

Analysis にてカテゴリーを 2 つだけ選択している時に「Fold Change by Category」が選択できます

（下図）。 

 

 

 

 

 

 

 

 

「Fold Change」を設定した場合、分母となるカテゴリーを選択し、もう  一方

との比が「Fold Change」列に表示されます。Samples 画面では分母に選ばれ

た方がベージュに、分子の方が薄紫色に色が塗られて表示されます（右図）。 

 

Missing value を 0 に置き換えた場合などで分母が 0 であった場合、Fold 

Change の値は「INF」と表示されます。 
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技術サポート  

ご質問等ありましたら弊社技術サポートにご連絡ください。 

電子メール ：support-jp@matrixscience.com 

電   話 ：03-5807-7897   


